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Preparing for installation

This chapter includes the following topics:
m  “Pre-installation software requirements”
m  “Requirements for NetBackup server installation”

m  “Configuring storage devices for the operating system”

Pre-installation software requirements

This release of NetBackup contains many changes and enhancements that have
caused the software to become larger. You can read a brief description of these
enhancements in the NetBackup Release Notes.

Depending on the type of platform you install, the growth in the software may
require you to mount more CDs than in earlier releases.

NetBackup license key requirements

When you install a NetBackup master or media server, you must enter a
NetBackup base product license key. Check your release package to make sure
that you have license keys for all the NetBackup servers, options, and agents
that you requested.

Enter all product license keys on the master server when you are prompted
during the installation.

For more information about license keys, refer to “NetBackup licenses” on
page 73.

For detailed information on how to administer NetBackup license keys, refer to
the Veritas NetBackup Administrator’s Guide, Volume I.
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NetBackup supported platforms

The NetBackup Release Notes document provides a “Supported Platforms and
Operating Systems” table that identifies which clients to install with which
operating systems.

You can run mixed versions of NetBackup between master and media servers.
This “back-level support” lets you upgrade NetBackup one server at a time,
which minimizes impact on overall system performance. Symantec supports
only certain combinations of servers and clients.

The following lists all of the configurations for which Symantec provides
support.

Master Server Version Media Server Version Client Version

NetBackup 6.5 6.5 6.5

NetBackup 6.5 6.5 6.0, 5.0MP4 (or later) or 5.1

NetBackup 6.5 6.0MP3 (or later), 5.0MP4 (or |6.0, 5.0MP4 (or later) or 5.1
later), or 5.1

Caution: Before you upgrade the NetBackup server software, you must back up
your NetBackup catalogs and verify that the catalog backup was successful.

Contents of the NetBackup media kit

Starting with this release, Symantec is delivering NetBackup in both CD-ROM
and DVD media formats. Starting with the next major release of NetBackup, the
product will only be available on DVD media.

Your NetBackup media kit includes multiple CDs or DVDs. The label on each CD
and DVD provides a brief description of its contents.

NetBackup documentation is included on both CD and DVD, and accompanies
each product order. The documentation is in Portable Document Format (PDF),
for all NetBackup software products in a release. The documentation is
organized into product groups. You can use Acrobat Reader to print the files you
select.

If Autorun is enabled on your Windows system, you see a Web page that lists the
documents that you can select to view. On UNIX or Linux systems, or if Autorun
is disabled on the Windows system, navigate to the CD drive to view the CD
contents. From that drive, you can select documents to view or copy them to a
local drive.
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The following table lists the title of each NetBackup 6.5 CD along with a brief
description of its contents.

Note: Beginning with NetBackup 6.5, Veritas Security Services and its associated

acronym (VxSS) are replaced by Symantec Product Authentication and

Authorization.

NetBackup CD

Contents

Windows 32-bit

Server/Client/Options

Windows [A-64-bit

Server/Client/Options

Windows X64-bit

Server/Client/Options

Solaris SPARC Server/Clients

Solaris x86-64-bit Server/Clients

HP-UX PA-RISC Server/Clients

HP-UX IA-64-bit Server/Client

Linux 2.4 Server/Client

Linux 2.6 Red Hat Server/Client

Linux IA-64-bit 2.6

Red Hat and SuSE Servers/Clients

Linux 2.6 SuSE Server/Client

AIX RS6000 Server/Client

Tru64 (Alpha) Server/Client

UNIX Client1 Tru64, all HP, and AIX

UNIX Client2 Mac and all Linux

UNIX Client3 Solaris, FreeBSD, and IRIX
BMR UNIX

UNIX Options UNIX Options/Database Agents
NOM NetBackup Operations Manager
Storage Migrator UNIX

NetBackup Document Set

Complete NetBackup documentation set in PDF format
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NetBackup CD Contents (Continued)

NetBackup Infrastructure Symantec Product Authentication & Authorization
Core Services (ICS for installers for Windows 32-bit
Windows 32-bit)

ICS Windows IA-64-bit Symantec Product Authentication & Authorization
installers for Windows IA-64-bit

ICS Windows X64-bit Symantec Product Authentication & Authorization
installers for Windows X64-bit

ICS Solaris SPARC Symantec Product Authentication & Authorization, and
PBX installers for Solaris SPARC

ICS Solaris x86-64-bit Symantec Product Authentication & Authorization, and
PBX installers for Solaris x86-64-bit

ICS HP-UX Symantec Product Authentication & Authorization, and

PA-RISC/IA-64-bit PBX installers for HP-UX PA-RISC/IA-64-bit

ICS Linux 2.4/2.6 Symantec Product Authentication & Authorization, and
PBX installers for Linux 2.4/2.6

ICS Linux 2.6 [A-64-bit Symantec Product Authentication & Authorization, and
PBX installers for Linux 2.6 IA-64-bit

ICS AIX Symantec Product Authentication & Authorization, and
PBX installers for AIX

ICS Tru64 Symantec Product Authentication & Authorization, and

PBX installers for Tru64

The following table lists the title of each NetBackup 6.5 DVD along with a brief
description of its contents.

NetBackup DVD | Contents

Windows 32-/
64-bit, ICS 32-
and 64-bit, and
UNIX clients

Windows 32-bit Server/Client/Options
Windows IA-64-bit Server/Client/Options
Windows X64-bit Server/Client/Options
ICS Windows 32-bit

ICS Windows IA-64-bit

ICS Windows X64-bit

UNIX Client1 (Tru64, all HP and AIX)
UNIX Client2 (Mac and all Linux)

UNIX Client3 (Solaris's, FreeBSD and IRIX)
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NetBackup DVD | Contents (Continued)
Solaris SPARC m  Solaris SPARC Server/Clients
and x86-64, m  Solaris x86-bit Server/Client
Linux, and ICS m  Linux 2.4 Server/Client
m  Linux 2.6 Red Hat Server/Client
m  Linux 2.6 [A-64-bit Red Hat/SuSE Servers/Clients
m  Linux 2.6 SuSE Server/Client
m  ICS Solaris SPARC
m  ICS Solaris x86-64-bit
m  ICSLinux 2.4/2.6 32-bit
m  ICS Linux 2.6 IA-64-bit
HP, AIX, Tru64, n HP-UX PA-RISC Server/Client
and ICS m  HP-UXIA-64 Server/Client
B AIX RS6000 Server/Client
m  Tru64 Server/Client
| | ICS HP-UX RISC/IA-64
m ICSAIX
m  ICS Tru64
BMR, UNIX | ] BMR for UNIX
Options, NOM, m  UNIX options
Storage Migrator, |m  NetBackup Operations Manager (UNIX and Windows)
& NetBackuP m  Storage Migrator
]S):tcumentatlon m Complete NetBackup documentation set in PDF format
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Requirements for NetBackup server installation

Before you install NetBackup, ensure that the following requirements are met:

m  Symantec recommends that you remove any other vendor backup software
currently configured on your system before you install this product. Other
vendor backup software can negatively affect how NetBackup installs and
functions.

m  Ignore references to media servers if you do not plan to install any. They are
not required.

m  Allow about 30 minutes to install the server software. Additional time is
required to configure the product for your environment.
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m  To accommodate the NetBackup server software and NetBackup catalogs,
Symantec recommends the following:

m  Master and media servers in a production environment with several
database agents enabled, should have a minimum of 2 GB of memory
each.

m  Any client in this type of environment should have a minimum of 512
MB of memory.

m  On the NetBackup server, the installation directory contains the software
and the NetBackup catalog. Both of these can become quite large.
If space is an issue, you can install NetBackup on an alternate file system.
The installation allows you to select an alternate install location, and
creates the appropriate link from /usr/openv.

m  Symantec does not support installation of NetBackup in an NFS-mounted
directory. File locking in NFS-mounted file systems can be unreliable.

m  For some peripherals and platforms, kernel reconfiguration is required. For
more details, see the Veritas NetBackup Device Configuration Guide.

m  For Red Hat Linux, NetBackup requires server networking.
Ensure that you have the following hardware and software already set up:

m  All NetBackup installation CDs, appropriate license keys, and the root
password for all servers.

m The gzip and the gunzip commands must be installed on the local
system. The directories where these commands are installed must be
part of the root user’s PATH environment variable setting.

m  Aserver of a supported hardware type that runs a supported version of
its operating system (with applicable patches), adequate disk space, and
supported peripherals. For details on these requirements, refer to the
NetBackup Release Notes.

m  All NetBackup servers must recognize and be recognizable by their
client systems. In some environments, this means that each must be
defined in the other’s /etc/hosts file. Other environments may use
the Network Information Service (NIS) or Domain Name Service (DNS).

m  For reasonable performance of the NetBackup-Java interfaces, you
need 512 MB of RAM. Of that space, 256 MB must be available to the
interface program (jnbSA or jbpSa).

m The minimum screen resolution configuration is 1024x768, 256 colors.
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Notes for Solaris systems

Several kernel-tunable parameters, such as Message Queue, Semaphore, and
Shared Memory Parameters, can affect NetBackup performance. If you adjust
these values, you may prevent your system performance from slowing down or
even reaching a deadlock state.

Refer to the NetBackup Backup Planning and Performance Tuning Guide on the
support Web site for more information, such as parameter definitions and
examples.

m  Message Queue parameters: It may be necessary to increase the system’s
message queue resources to avoid having NetBackup daemons hang.
For example, you may need to edit the /etc/systemfile to include or
change the following parameters:
set msgsys:msginfo_msgmap=512
set msgsys:msginfo_msgmax=8192
set msgsys:msginfo_msgmnb=65536
set msgsys:msginfo_msgmni=256
set msgsys:msginfo_msgssz=16
set msgsys:msginfo_msgtgl=512
set msgsys:msginfo_msgseg=8192

After editing the file, you must reboot the NetBackup server.

m  Semaphore parameters: You must allocate enough semaphores on UNIX
systems, or errors may occur. System requirements vary, but the following
changes to the /etc/systen file should be sufficient for an average
system:

set semsys:seminfo_semmap=64

set semsys:seminfo_semmni=1024

set semsys:seminfo_semmns=1024

set semsys:seminfo_semmnu=1024

set semsys:seminfo_semmsl1=300

set semsys:seminfo_semopm=32

set semsys:seminfo_semume=64

After editing the file, you must reboot the NetBackup server.

m  For older levels of Solaris, you may need to change one or more default
System V Shared Memory settings to prevent the following job failure:
System cannot allocate enough shared memory; NetBackup status code 89.
If you modify any of the following settings in the /etc/systemn file, you
must reboot the system with boot -r for the new settings to take effect.
Refer to your vendor documentation for detailed instructions on how to
modify these values.
®  shmsys:shminfo_shmmax

For Solaris 8, the default value is 1 megabyte. For Solaris 9, the default
value is 8 megabytes. To increase this setting, you can place the
following line in your /etc/system file:
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set shmsys:shminfo_shmmax=33554432

A value of 32 megabytes has been used in this example. Some systems
may require a greater value, such as systems with a high value for the
NetBackup multiplexing parameter. According to the Sun
Microsystems documentation, setting this parameter to its maximum
value has no side effects. (This parameter is not applicable to Solaris
10).

shmsys:shminfo_shmmni

For Solaris 8 or 9, the default value is 100. The default value is usually
sufficient for NetBackup. However in some environments, such as
installing a NetBackup media server on a large database server, this
setting may need to be increased. To increase this setting, you can place
the following line in your /etc/systen file:

set shmsys:shminfo_shmmni=220

A value of 220 has been used in this example. (This parameter is not
applicable to Solaris 10).

shmsys:shminfo_shmseg

For Solaris 8, the default value is 6. The default value is usually
sufficient for NetBackup. However in some systems, such as installing a
NetBackup media server on a large database server, this setting may
need to be increased. To increase this setting, you can place the
following line in your /etc/systemfile:

set shmsys:shminfo_shmseg=10

A value of 10 has been used in this example. (This parameter is not
applicable to Solaris 9 or 10).

shmsys:shminfo_shmmin

For Solaris 8, if you change this setting in the /etc/systemfile, it
must be 100 or less for NetBackup processes to run. (This parameter is
not applicable to Solaris 9 or 10).

Notes for HP-UX systems

Use the following guidelines when you install NetBackup on HP-UX systems.

Install NetBackup on a file system that supports long file names.

During NetBackup installation, the following error may occur when the
NetBackup database is created:

SQL error (-832) -- Connection error: Insufficient system
resources - failed to allocate a SYSV semaphore

To correct the error, increase the number of semaphores in the HP-UX
kernel.



Preparing for installation | 17
Requirements for NetBackup server installation

For details on how to change HP-UX parameters, refer to the Veritas
NetBackup Backup Planning and Performance Tuning Guide, Chapter 11:
OS-Related Tuning Factors.

Notes for private branch Exchange (PBX)

NetBackup uses an Infrastructure Core Services (ICS) product that is called
Private Branch Exchange (PBX).

PBX helps limit the number of TCP/IP ports that NetBackup uses. It also allows
all socket communication to take place when NetBackup connects through a
single port. The PBX port number is 1556.

For more information about PBX and how to configure NetBackup ports, refer to
the Veritas NetBackup Security and Encryption Guide.

Because PBX is required for all NetBackup products, its installation is part of the
NetBackup installation procedure. The only exception is when it is already
present on the system.

When you install NetBackup on a server, the installation procedure determines
if a version of PBX is already installed. Whether PBX is installed causes one of
the following to happen:

m If an acceptable version of PBX already exists, the installation procedure
uses that version of PBX and continues.

m If PBX does not exist or needs to be upgraded, you see a message similar to
the following:

The following package(s) are missing and must be installed
before NetBackup can be installed:

VRTSpbx

The package(s) are located on the Infrastructure Core Services (ICS) CD,
which is included in the NetBackup media kit.

See step 6 on page 28 for details on PBX installation.

Notes for clustered environments

Use the following guidelines when you install NetBackup in clustered systems.

m  Ensure that each node in the NetBackup cluster can run the rsh command
or its equivalent (on HP-UX, the command is remsh). The root user must be
able to perform a remote login to each node in the cluster without entering a
password. This remote login is necessary for installation and configuration
of the NetBackup server and any NetBackup agents and options. After
installation and configuration is complete, it is no longer required.

®  You must install, configure, and start the cluster framework before you
install NetBackup. Refer to the Veritas NetBackup High Availability
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Administrator’s Guide for additional installation prerequisites and
installation notes.

m  You must have defined a virtual name using DNS, NIS, or /etc/hosts. The
IP address is defined at the same time. (The virtual name is a label for the IP
address.) Use this virtual name and IP address only for the NetBackup
resource.

Notes for NetBackup Access Control
Use the following guidelines if you want to use access control:

m  To use the access control features in NetBackup 6.5, you must install the
Symantec Product Authentication and Authorization components.

m If access control is not installed in your current NetBackup
environment, you must first upgrade to NetBackup 6.5. Then, you can
install the access control components.

m If access control is already installed in your current NetBackup
environment, you must install the new access control components
before you upgrade to NetBackup 6.5.

For NetBackup Access Control installation and upgrade instructions, see

the Veritas NetBackup Security and Encryption Guide.

Configuring storage devices for the operating
system

Reliable use of NetBackup depends on the proper configuration of your storage
devices.

To ensure reliable backups and restores, you must configure devices to work
with the operating system. Use the instructions that the device vendor and
operating system vendor provide. Install and configure storage devices before
you install and configure NetBackup.

Warning: An improperly configured device may lead to loss of data during
restores.

Locating supported robot types

You can find a list of the supported robot types in the NetBackup Release Notes.

Symantec periodically adds new robots to this list. For your convenience,
Symantec updates the supported robots lists on the Symantec support Web site.
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To find the latest devices this release supports

1
2

In a Web browser, open http://entsupport.symantec.com.

In the Product Lookup list, select either NetBackup Enterprise Server or
NetBackup Server.

In the new Web page in the Support for this product section, click
Compatibility List.

In the new Compatibility and Reference Web page from the appropriate
drop-down menus, select Compatibility > NetBackup 6.5, and the language
of your choice.

The lower section of the screen updates depending on what you select from
the drop-down menus. From the links on this section of the screen, select
the appropriate product level to check compatibility.

From the resulting page you can view device support information by
individual vendor, all support drives, libraries, or robot types.

Configuring storage devices

Use the following guidelines to configure your storage devices:

Configure your storage devices as described in the instructions that the
device vendor and operating system vendor provide.

For new installations, Symantec recommends that you install and configure
the latest device drivers for your storage devices immediately before you
install the NetBackup software.

After you have configured your storage devices, you can install NetBackup.

For upgrades, you can install the latest device drivers before you upgrade
NetBackup.

The Tape Device Driver Installation wizard that is included on the
NetBackup installation CD steps you through how to install the latest device
drivers.

Note: Complete this wizard before you configure NetBackup.

If you do not have a NetBackup CD, you can download the NetBackup Tape
Device Driver Installation software from the technical support Web site:
http://entsupport.symantec.com

To start the tape device driver installation wizard

1

Log on as administrator to the system where you installed NetBackup.
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2 Insert the NetBackup CD in the drive.

3 Onthe installation browser, click the link Additional Products > Additional
Product Installations > NetBackup Tape Device Drivers.

4 Complete the wizard to install the latest device drivers for your storage
device.

Note: You can download the latest external device mapping files on the Updates
and Patches Web page on the support Web site: http://entsupport.symantec.com
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This chapter includes the following topics:
m  Mounting the software media
m Installing NetBackup servers

m  “Installing client type software on a master server”

Mounting the software media

Use the following directions as a guideline when you mount NetBackup CDs and
DVDs. Check with your hardware vendor to see if you may need to use other
flags or options.

Note: Mounting DVDs is basically the same as mounting a CD. To make sure you
mount the correct CD or DVD, refer to “Contents of the NetBackup media kit” on
page 10.

The examples in this section use the following options and arguments:
m A -v, -t, or -F option specifies the type of file system to mount.

m A -ooption on systems other than IRIX translates files names properly, if
required. On IRIX systems, a -o ro option specifies that you want to mount
the CD or DVD as read-only.

m A -r option specifies that you want to mount the CD or DVD for reading.
m The device_path specifies the name of the CD or DVD drive.

m  The mount_point specifies the directory where you want to mount the CD
or DVD.
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AIX

1 Loginasroot.

2 Mount the CD or DVD with one of the following methods:

m  Using smitty:
smitty cdrfs
OR

smitty mountfs

m  Manually:
m  Create the mount point (for example, mkdir /cdrom).
m  Runthe mount command, as follows:
mount -v cdrfs -r device_path mount_point
For example, the following command mounts the CD or DVD
manually with /cdrom as the mount point and /dev/cd0 as the
device path:

mount -v cdrfs -r /dev/cd0 /cdrom

Alpha Tru64

1 Loginasroot.
2 Create the mount point (for example, mkdir /cdrom).

3 Mount the CD or DVD, as follows:
mount -r -t cdfs -o noversion device path mount_point
For example, the following command mounts the CD or DVD using /cdrom
as the mount point and /dev/disk/cdromOa as the device path:

mount -r -t cdfs -o noversion /dev/disk/cdrom0Oa /cdrom

FreeBSD

1 Login asroot.
2 Create the mount point (for example, mkdir /cdrom).

3 Mount the CD or DVD, as follows:
mount -r -t cd9660 device path mount_point
For example, the following command mounts the CD or DVD using /cdrom
as the mount point and /dev/acdOc as the device path:
mount -r -t cd9660 /dev/acdOc /cdrom
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To mount and unmount the CD or DVD on HP-UX varies, depending on the
version of the operating system you are running.

To mount the CD or DVD on HP-UX 11.23 or later operating systems

1
2

Log in as root.

Mount the CD or DVD, as follows:

mount -F cdfs device path mount_point

To unmount the CD or DVD on HP-UX 11.23 or later operating systems

3

4

Unmount the CD or DVD, as follows:

umount mount_point

Remove the CD or DVD from the drive.

To mount the CD or DVD on HP-UX operating systems earlier than 11.23

1
2
3

Log in as root.
Create the mount point (for example, mkdir /cdrom).

Start the PFS daemons, as follows:

nohup pfs_mountd &

nohup pfsd &

Mount the CD or DVD, as follows:

pfs_mount -o xlat=unix device path mount_point

To find the device path, you can run ioscan -fn.

For example, the following command mounts the CD or DVD using /cdrom
as the mount point and /dev/rdsk/c3t2d0 as the device path:
pfs_mount -o xlat=unix /dev/rdsk/c3t2d0 /cdrom

To unmount the CD or DVD on HP-UX operating systems earlier than 11.23

1

Unmount the CD or DVD, as follows:

pfs_umount mount_point

For example, the following command unmounts a CD or DVD that used
/cdrom as the mount point:

pfs_umount /cdrom

Stop the following processes with the ki11 command:
pfs_mountd

pfsd

pfs_mountd.rpc

pfsd.rpc

23



24

Installing NetBackup
Installing NetBackup servers

IRIX

Linux

Solaris

Log in as root.
You can use the mediad command to auto-mount the CD or DVD.

If mediad does not work, perform the following steps:
m Create the mount point (for example, mkdir /cdrom).
m  Mount the CD or DVD, as follows:

mount -o ro -t 1s09660 device_path mount_point

You can determine the device_pathby running a hardware inventory
with the hinv command.

For example, the following command mounts the CD or DVD using /cdrom
as the mount point and /dev/rdsk/dks0d6vol as the device path:

mount -o ro -t iso09660 /dev/rdsk/dks0d6vol /cdrom

Log in as root.
Create the mount point (for example, mkdir /cdrom).

Mount the CD or DVD, as follows:

mount device_path mount_point

For example, the following command mounts the CD or DVD using /cdrom
as the mount point and /dev/cdrom as the device path:

mount /dev/cdrom /cdrom

Log in as root.

If Volume Manager (vo1ld) is running, the CD or DVD mounts automatically.
If vold is not running, start it up as follows:
/usr/sbin/vold &

Installing NetBackup servers

This section describes the procedures for install NetBackup server software.
Before you install NetBackup, check the following:

Review “Preparing for installation” on page 9.

Make sure you have installed the most current operating system patches
and updates on your system. If you are not certain of your operating system
level, contact your vendor and request the latest patches and upgrades.
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To use the access control features in NetBackup 6.5, you must install the
Symantec Product Authentication and Authorization components.

m If access control is not installed in your current NetBackup
environment, you must first upgrade to NetBackup 6.5. Then, you can
install the access control components.

m If access control is already installed in your current NetBackup
environment, you must install the new Symantec Product
Authentication and Authorization components before you upgrade to
NetBackup 6.5.

For NetBackup access control installation and upgrade instructions, see the

Veritas NetBackup Security and Encryption Guide.

How the installation script works

In addition to NetBackup server software installation, the installation script
does the following:

Places the name of the host in the /usr/openv/netbackup/bp.conf file
on the server.

For clustered environments:

The script places the virtual host name in the
/usr/openv/netbackup/bp.conf file on the server.

Adds the necessary entries to the /etc/services file for NetBackup and
Media Manager services (for example, robotic daemons). The
/etc/services file contains UNIX system information.

Checks to see if your server is running Network Information System (NIS).
NIS is the UNIX directory service utility. If it is running, you are instructed
to add entries to your NIS services map.

Adds automatic startup and shutdown scripts to the appropriate directories
on the various supported platforms.

Note: These scripts are removed in clustered environments.

Adds the necessary entries to the following server file or directory to
facilitate networking:

/etc/inetd.conf file

OR

/etc/xinetd.d directory

Entries are added for bpcd, vnetd, vopied, and bpjava-msvc. After they
are added, the script signals inetd (or xinetd) to read the updated file.
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m  Before you install or use NetBackup on a Linux (Red Hat/SuSE) client,
verify that the inetd (or xinetd) service is started on that machine.
This service ensures proper communication between the NetBackup
master server and the Linux client.

m  For Solaris 10: The inetd. conf entries are also converted into smf
service manifests and imported into the smf repository by using the
inetconv command.

For Solaris systems:

The installation procedure prompts you for the name of an alternate root
path. An alternate boot environment lets you install NetBackup on a
different server.

For example, suppose that Host B’s root, usr, and var file systems are
mounted on Host A as /alt, /alt/usr,and/alt/var. When you log in to
Host A, you can specify /alt as the alternate root environment and install
NetBackup on Host B. This feature applies to NetBackup servers only and
not add-ons, clients, or database agents.

Installation sequence

For new NetBackup installations, install the software in the following order:

Master Server

Media Server

NetBackup Remote Administration Console
Clients

Any NetBackup add-on products

Installing NetBackup master server software

The master server manages backups, archives, and restores. The master server
is where the NetBackup catalog resides which includes the internal databases
that contain information about NetBackup configuration and backups.

Use the following guidelines for master server installation:

Designate the computer you want to be the master server and install the
master server software on that machine first.

By default, the installation script installs the Enterprise Media Manager
(EMM) Server software on the master server. This is the preferred
configuration.



Installing NetBackup | 27
Installing NetBackup servers

Note: Although installing the EMM on a media server is supported,
Symantec recommends that you install the EMM on the master server. For
instructions that describe EMM installation on a media server, please refer
to TechNote 278175.

During master server installation, you must enter a NetBackup product
license key. You must also enter license keys for any additional NetBackup
product options or agents that are used on the server or its clients. These
additional license keys must be entered on the master server.

For more information on how to administer NetBackup licenses, see the
Veritas NetBackup Administrator’s Guide, Volume I.

Note: If you add, delete, or make and save any license key updates in the
NetBackup-Java Administration Console, you must restart the console.

To install NetBackup master server software

1
2

Log in to the server as root.

Insert the appropriate NetBackup CD or DVD in the drive and mount it, if
necessary.

For instructions on how to mount the CD or DVD on your operating system,
refer to the appropriate section of “Mounting the software media” on

page 21. For information on CD and DVD contents, refer to “Contents of the
NetBackup media kit” on page 10.

Run the following installation script, which installs NetBackup server,
Media Manager, and client software on the server:

cd_directory/install

The cd_directory is the path to the directory where you can access the CD or
DVD.

When the installation script starts, the following message appears:

Installing NetBackup Server Software

NOTE: To install only NetBackup Client software locally on this
machine or to load additional UNIX client software on this
server, insert the NetBackup UNIX Clients cdrom.

Do you wish to continue? [y,n] (y)
Press Enter to accept the default (y) and continue with the server
installation.

NetBackup is set up to install to the running root environment by default.

m Toinstall to the running root environment, press Enter.


http://entsupport.symantec.com/docs/278175.htm
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m  To change the NetBackup installation location, type [n] and identify
the appropriate path where you want NetBackup installed.

When you see the following message, type [y].

NetBackup and Media Manager binaries will be installed in
/opt/openv

and a link will be created from /usr/openv to opt/openv, if it
does not exist.

Is this okay? (y) ly, n,?, gl

This step applies only if you do not have Symantec Private Branch Exchange
(PBX) currently installed on your system.

NetBackup 6.5 contains some features that are dependent on the
Infrastructure Core Services (ICS) product, called Symantec Private Branch
Exchange (PBX).

PBX helps limit the number of TCP/IP ports that many new features in
NetBackup use. In addition, it allows all socket communication to take place
while connecting through a single port. The PBX port number is 1556. For
more information about PBX and how to configure NetBackup ports, refer
to the Veritas NetBackup Administration Guide, Volume I.

Because PBX is required for all NetBackup products, its installation is part
of the NetBackup installation procedure unless it is already present on the
system. When you begin to install NetBackup on a server, the installation
procedure determines if a version of PBX is already installed. Whether PBX
is currently installed causes one of the following to happen:

m If an acceptable version of PBX already exists, the installation
procedure uses that version of PBX and continues.

m If PBX does not exist, you see a message similar to the following:
The following package(s) are missing and must be
installed before NetBackup can be installed:
VRTSpbx
The listed package(s) are part of the Symantec
Infrastructure Core Services (ICS) CDs/DVDs which are
included in the corresponding NetBackup media kit.

To install PBX from a CD:

Use the displayed instructions as follows:

B From a different window, unmount/eject the
NetBackup cdrom and insert/mount the ICS cdrom.
Make sure the ICS CD has been properly mounted and
files are visible.

B Enter the full path name to the directory where
the appropriate installics script is located
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followed by a <CR> to continue. This script will
then install the package(s).

To install PBX from a DVD:

10

Use the displayed instructions as follows:

B The ICS image is contained on the currently
mounted media at:
dvd_directory/mounted ICS location
Do you want to install the listed package(s) now?
ly,n] (vy)

m Press Enter to install PBX from the mounted DVD.

Enter the NetBackup Server or Enterprise Server license key.

Type [¥], then follow the prompts to add license keys for other NetBackup
options and agents.

Although you can add license keys later, you should enter them now. If you
add any license keys later through the NetBackup-Java Administration
Console, you must restart the console.

After all license keys are entered, type [q] to quit the License Key Utility
and complete the server software installation.

Verify or enter the correct machine name when prompted by the following
message:

Installing NetBackup Enterprise Server version: 6.5GA

If this machine will be using a different network interface than
the default (machine name), the name of the preferred interface
should be used as the configured server name. If this machine
will be part of a cluster, the virtual name should be used as the
configured server name.

The domain name of your server appears to be (name.domain). You
may choose to use this domain name in your configured NetBackup
server name, or simply use (machine name) as the configured
NetBackup server name.

Would you like to use (name.domain) as the configured name of
the NetBackup server? [y, n] (y)

m  To accept the displayed (default) name, press Enter.
m  To change the displayed (default) name, type [n] and enter the name
you want.

For a clustered NetBackup server, enter the virtual name for the
NetBackup server and not the actual local host name.
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11

12

13

14

Identify or verify the master server by answering the following question

when it appears:

Is <name> the master server? [y, n] (y)

m  Press Enter to accept the displayed name (which is the machine name
you identified in the previous step).

Identify whether there are any media servers for this master server by

answering the following question when it appears:

Do you have any media servers? [y, n] (n)

m If there are no media servers for this master server, press Enter and
proceed to the next step.

m If there are media servers for this master server, type [v].

m  Enter the name of each media server.
When you enter the media server names, you must enter the
machine name and domain name. For example:
alpha.min.symantec.com
where alpha is the machine name and min. symantec.comis the
domain name.
The media server names that you enter here are added to the
bp . conf file on the master server, automatically. After you install
the media server software later, the master server can then
communicate with the media servers immediately.

When the following message appears, identify the name of the EMM server.

NetBackup maintains a centralized catalog (separate from the
image catalog) for data related to media and device
configuration, device management, storage units, hosts and host
aliases, media server status, NDMP credentials, and other
information. This is managed by the Enterprise Media Manager
server.

Enter the name of the Enterprise Media Manager (default: name)

m  To accept the displayed (default) master server name and install the
EMM server on the master server, press Enter.

m  On aclustered master server, enter the virtual name of the master
server.

Note: Symantec does not support installing the EMM on an NFS-mount.

Answer the following question when it appears:

Do you want to start the NetBackup bprd process so backups and
restores can be initiated? [y, n]l (y)

m If you have (or want to have) a clustered NetBackup server, type [n].

m Press Enter to start NetBackup processes and the EMM server.
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You must start these processes now because the EMM server must be
running when you install any media servers later.

15 For a clustered NetBackup master server, perform step 1 through step 14 on
every node on which you want to run NetBackup.

Note: For TruCluster, you only have to perform the installation once
because /usr/openv is shared.

After you have installed the server software on all nodes, run the following
command on the active node:
/usr/openv/netbackup/bin/cluster/cluster_config

When the cluster_config script runs, it prompts you for a cluster name.
You must provide the same virtual cluster name that you provided during
the installation.

The cluster name is also case-sensitive. If applicable, provide the fully
qualified name. For example, if you indicate the name
“clusternb.domain.com” during installation, you must use this exact name

for the cluster_config script. Otherwise, the configuration process fails.

Continuing with NetBackup software installation

After you have installed the master server software, you are ready to install
media server software or client software depending on your environment.

m If you have media servers in your system:
Proceed to “Installing NetBackup media server software” on page 31.

m  If there are no media servers in your environment, you are ready to install
client software on client machines.

m Toinstall client software on each individual client, see “Installing UNIX
clients locally” on page 89.

m To install client software on clients from the master server location
(recommended), you must first install the client type software on the
master server. See “Installing client type software on a master server”
on page 35.

Installing NetBackup media server software
Media server software manages the robotic and the storage devices within your
NetBackup environment.

After you have installed the master server software and the EMM server
software, you are ready to install media server software on media server
machines.
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Use the following guidelines when you install media servers:

Designate the computers that you want to be media servers and install the
media server software on those machines.

The EMM server must be installed and running before you install media
server software.

When you install NetBackup media server software, you must enter a
NetBackup product license key. You must also enter license keys for any
additional NetBackup product options or agents that are used on the server
or its clients. These additional license keys must be entered on each media
server.

For more information on how to administer NetBackup licenses, see the
Veritas NetBackup Administrator’s Guide for UNIX and Linux, Volume L.

Note: If you add, delete, or make and save any license key updates in the
NetBackup-Java Administration Console, you must restart the console.

To install NetBackup media server software

1
2

Log in to the server as root.

Insert the appropriate NetBackup CD or DVD in the drive and mount it, if
necessary.

For instructions on how to mount the CD or DVD on your operating system,
refer to the appropriate section of “Mounting the software media” on

page 21. For information on CD and DVD contents, refer to “Contents of the
NetBackup media kit” on page 10.

Run the following installation script, which installs NetBackup server,
Media Manager, and client software on the server:

cd_directory/install

The cd_directory is the path to the directory where you can access the CD or
DVD.

When the installation script starts, the following message appears:

Installing NetBackup Server Software

NOTE: To install only NetBackup Client software locally on this
machine or to load additional UNIX client software on this
server, insert the NetBackup UNIX Clients cdrom.

Do you wish to continue? [y,n] (y)
Press Enter to accept the default (y) to continue with the server
installation.

NetBackup is set up by default to install to the running root environment.
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m To install to the running root environment, press Enter.

m  Tochange the NetBackup installation location, type [n] and identify
the appropriate path where you want NetBackup installed.

5 When you see the following message, type [y¥].
NetBackup and Media Manager binaries will be installed in
/opt/openv
and a link will be created from /usr/openv to opt/openv, if it
does not exist.
Is this okay? (y) [y, n,?, gl

6 This step applies only if you do not have Symantec Private Branch Exchange
(PBX) currently installed on your system.
NetBackup 6.5 contains some features that are dependent on the
Infrastructure Core Services (ICS) product, called Symantec Private Branch
Exchange (PBX).
PBX helps limit the number of TCP/IP ports that many new features in
NetBackup use. In addition, it allows all socket communication to take place
while connecting through a single port. The PBX port number is 1556. For
more information about PBX and how to configure NetBackup ports, refer
to the Veritas NetBackup Administration Guide, Volume L.
Because PBX is required for all NetBackup products, its installation is part
of the NetBackup installation procedure unless it is already present on the
system. When you begin to install NetBackup on a server, the installation
procedure determines if a version of PBX is already installed. Whether PBX
is currently installed causes one of the following to happen:

m If an acceptable version of PBX already exists, the installation
procedure uses that version of PBX and continues.

m If PBX does not exist, you see a message similar to the following:
The following package(s) are missing and must be
installed before NetBackup can be installed:
VRTSpbx
The listed package(s) are part of the Symantec
Infrastructure Core Services (ICS) CDs/DVDs which are
included in the corresponding NetBackup media kit.

To install PBX from a CD:
Use the displayed instructions as follows:

B From a different window, unmount/eject the
NetBackup cdrom and insert/mount the ICS cdrom.
Make sure the ICS CD has been properly mounted and
files are visible.
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B Enter the full path name to the directory where
the appropriate installics script is located
followed by a <CR> to continue. This script will
then install the package(s).

To install PBX from a DVD:

10

Use the displayed instructions as follows:

B The ICS image is contained on the currently
mounted media at:
dvd_directory/mounted ICS location
Do you want to install the listed package(s) now?
ly,n] (vy)

m Press Enter to install PBX from the mounted DVD.

Enter the NetBackup Server or NetBackup Enterprise Server license key.

Type [¥], then follow the prompts to add license keys for other NetBackup
options and agents.

Although you can add license keys later, you should enter them now. If you
add any license keys later through the NetBackup-Java Administration
Console, you must restart the console.

After all license keys are entered, type [q] to quit the License Key Utility
and complete the server software installation.

Verify or enter the correct machine name when prompted by the following
message:

Installing NetBackup Enterprise Server version: 6.5GA

If this machine will be using a different network interface than
the default (machine name), the name of the preferred interface
should be used as the configured server name. If this machine
will be part of a cluster, the virtual name should be used as the
configured server name.

The domain name of your server appears to be (name.domain). You
may choose to use this domain name in your configured NetBackup
server name, or simply use (machine name) as the configured
NetBackup server name.

Would you like to use (name.domain) as the configured name of
the NetBackup server? [y, n] (y)
m If the displayed (default) media server name is correct, press Enter.

m If the displayed (default) media server name is not correct, type [n]
and enter the correct name.
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m  For a clustered NetBackup server, type [n] and enter the virtual name
for the NetBackup server and not the actual local host name.

11 Identify the master server that you have already installed, by answering the
following question when it appears:
Is (name) the master server? [y,n]
m  Type [n] and enter the fully qualified name of the master server.
If the master server is clustered, enter the virtual name of the master
server.

12 When the following message appears, identify the name of the EMM server.
Enter the name of the Enterprise Media Manager (default: name)
The master server name is displayed by default.

m Ifyouinstalled the EMM server on the master server, press Enter to
accept the displayed (default) name.
If you have a clustered master server, enter the virtual name for the
master server and not the actual local machine name.

13 For a clustered NetBackup server, perform step 1 through step 12 on every
node on which you want to run NetBackup.

Note: For TruCluster, you only have to perform the installation once
because /usr/openv is shared.

After you have installed the server software on all nodes, run the following
command on the active node:
/usr/openv/netbackup/bin/cluster/cluster_config

When the cluster_config script runs, it prompts you for a cluster name.
You must provide the same virtual cluster name that you provided during
the installation.

The cluster name is also case-sensitive. If applicable, provide the fully
qualified name. For example, if you indicate the name
“clusternb.domain.com” during installation, you must use this exact name
for the cluster_config script. Otherwise, the configuration process fails.

14 Repeat step 1 through step 12 to install media server software on any
remaining media servers.

Installing client type software on a master server

Client type software must be installed on the master server in order to perform
the following operations:

m  Assign clients to NetBackup policies so that those clients can be backed up
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Make sure that you install the software for all of the UNIX client types you
intend to back up onto the server. Otherwise, you cannot add these client
types to the NetBackup policy configuration.

m Install (or push) client software from the master server to clients
For each UNIX client type, the client installation script lets you install the
client software onto the master server. You can then “push” the client
software from the master server to the clients.

To install client type software on a master server

1 Mount the appropriate client CD or DVD.

2 Select the client type that you want to install and follow the prompts to
install that client type.

3 Continue to select client types as necessary until all your client types have
been installed, and then unmount the client CD or DVD.

Notes on pushing client software from a master server to clients

Use the following guidelines to prepare your NetBackup environment for client
software installation from the master server.

m  Before you can push client software from the master server, each client
name must be assigned to a NetBackup policy. Policies are created on the
master server.

m  When you create a policy, you must identify the policy type, which indicates
the operating system on the clients that are assigned to that policy. Without
a policy, the remote installation (or push) fails because the master server
does not know the operating system of the client.

m  For information on how to create NetBackup policies, refer to the Veritas
NetBackup Administrator’s Guide for UNIX and Linux, Volume L.

m  For procedures on how to push client software from the master server, see
“Installing UNIX clients remotely” on page 90.

Configuring the window manager for the Java Interface
(NetBackup-Java compatible platforms)

Always set your window manager so windows become active only when you click
inside the windows. Do not enable auto focus, where windows become active if
you move the mouse pointer over them. The NetBackup-Java interfaces do not
run properly with auto focus enabled.
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CDE (Common Desktop Environment)

The CDE (Common Desktop Environment) window manager is the preferred
window manager for NetBackup-Java applications.

To set up a CDE window manager

1  On the front panel in the CDE window, click the Style Manager control icon.

2 On the Style Manager toolbar, click the Window control icon.

3 Inthe Style Manager - Window dialog box, select Click In Window To Make
Active.
Click OK.

4  When you see the Restart the Workspace Manager prompt, click OK.

Any NetBackup add-on products

After your initial installation is complete, you can install any other NetBackup
agents and options (such as NetBackup for Oracle).
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Installing alternative
administration interfaces

This chapter includes the following topics:
m  “About the NetBackup Remote Administration Console for Windows”
m  “About the NetBackup-Java Administration Console”

m  “About the Java Windows Administration Console”

About the NetBackup Remote Administration
Console for Windows

If your NetBackup server has no graphics display capabilities, you must install

an alternative administrative interface. It may also be desirable for various
other configurations, such as mixed Windows and UNIX environments.

Note: You can skip this section if you do not want or need to administer a
NetBackup server remotely from a Windows NetBackup client.

The NetBackup Remote Administration Console is an interface-only version of
NetBackup for Windows that you can use to administer NetBackup servers from

another machine.

The following describes which interface to install, based on the operating
system:

Windows NetBackup Remote Administration Console for Windows or

NetBackup-Java Administration Console for Windows
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UNIX NetBackup-Java Administration Console

Multiple versions of the NetBackup-Java Administration Console

The following is a brief description of the NetBackup Remote Administration
Console operation:

The console lets you perform all NetBackup operations exactly like the
NetBackup Administration Console on a local Windows NetBackup server.
You can create backup policies, manage volumes, view status, monitor tape
drives, and perform other operations.

The console displays the name of the server it administers, rather than a
local host name.

The console can only administer other NetBackup servers. It cannot act as a
master or a media server.

Installing the NetBackup Remote Administration Console

The NetBackup Remote Administration Console is supported on Windows
2000/XP/2003 Server. For additional information about the supported
platforms for this NetBackup release, refer to the Supported Platforms and
Peripherals chapter in the NetBackup Release Notes.

Installation is a two step process as follows:

Install the NetBackup Remote Administration Console

Add the NetBackup Remote Administration Console host to server lists

To install the NetBackup Remote Administration Console

1

o B~ W N

On the computer on which you want to install the NetBackup Remote
Administration Console, insert the CD that contains the NetBackup server
software for Windows.

m  On Windows systems with Autorun enabled, the installation browser
starts automatically.

m  On Windows systems that have Autorun disabled, navigate to the CD
drive and run Launch. exe.

On the initial screen, click NetBackup Installation.
On the Installation screen, click Install Server Software.
On the Welcome screen, click Next.

On the License Agreement screen, accept the terms of the license agreement
and click Next.
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6 On the Installation Type screen, select Install to this computer only and
Typical.
Click Next.

7 On the NetBackup License Key and Server Type screen, select NetBackup
Remote Administration Console. You do not need a license key to install the
Remote Administration Console.

8 On the NetBackup System Names screen, provide the following information:

Client Name Enter the name of the local machine where you are installing
the remote console. (The name should appear by default.)

Master Server Enter the name of the NetBackup master server. (The name
should appear by default.)

Additional Servers  Enter the names of any additional machines (servers) that are
allowed to access this server. If you enter more than one
name, separate each name with a comma.

Install LiveUpdate  Leave this box checked so that the agent is installed.
Agent LiveUpdate lets you download and install patches for
NetBackup.

Even if you choose not to use LiveUpdate, agent installation
does not affect NetBackup installation, configuration, or
operation.

For complete information on LiveUpdate, refer to “About
NetBackup LiveUpdate” on page 111.

9  On the Ready to Install the Program screen, click Install.

10 After the installation completes, you can either add license keys (click Add
Keys) or click Finish.
If you left the check box next to Launch NetBackup Administration Console
now checked, the Remote Administration Console appears. If you removed
the check, start the console by choosing Start > Programs > Veritas
NetBackup > NetBackup Administration Console.

Adding the NetBackup Remote Administration Console host
to server lists

The following methods are available to add the NetBackup Remote
Administration Console host to the server list on a master or a media server:

m  Use the NetBackup Administration Console for UNIX (if your system is
Java-compatible)

m Edit the bp. conf file



42

Installing alternative administration interfaces
About the NetBackup Remote Administration Console for Windows

To add the NetBackup Remote Administration Console host to the UNIX
server list of the remote server by using the NetBackup Administration

Console

1 Inthe left pane of the NetBackup Administration Console for UNIX, select
Host Properties > Master Servers.

2 In the Master Servers window in the right pane, right-click the name of the
host server and select Properties.

3 Inthe Master Server Properties window, click the Servers icon from the tree
in the left pane.

4 In the Servers window, click Add.

5 Enter the name of the host that is to run the NetBackup Remote
Administration Console.

6  Click Add. The name of the host appears in the Additional Servers list.

7  Click Close and OK.

To add the NetBackup Remote Administration Console host to the UNIX
server list of the remote server by editing the bp.conf file

1
2

Log in to the UNIX master server as root.

Edit /usr/openv/netbackup/bp.conf.

At the end of the SERVER = lines, add the following line:

SERVER = Remote-Administration-Console-machine-name

The Remote-Administration-Console-machine-name is the name of the
machine where you installed the NetBackup Remote Administration
Console.

Adding remote servers to administer from an existing NetBackup
Remote Administration Console

If you have an existing NetBackup Remote Administration Console installed and
you want to add a remote master server to administer, perform the following
steps.

To add a remote server to administer from an existing NetBackup Remote
Administration Console

1

2

Log on to the server where the NetBackup Remote Administration Console is
installed, and open the console.

In the left pane of the NetBackup Remote Administration Console, select
Host Properties > Master Server.
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3 Inthe Master Servers window in the right pane, right-click the name of the
host server and select Properties (Read/Write).

4 In the Master Server Properties window, click the Servers tab.

5 Inthe Global Operations field, in the Add to all lists field, enter the host
name. Make sure you enter the name of the host that is to run the
NetBackup Remote Administration Console.

6  Click the + button (the name of the host appears in the Additional Servers
list), then click OK.

About the NetBackup-Java Administration Console

The NetBackup-Java Administration Console can be used to administer one or
more UNIX or Windows NetBackup servers. It provides all of the standard
NetBackup server interfaces. The console can be used on a remote NetBackup
server to create backup policies, manage volumes, view status, monitor tape
drives, and other operations.

On Java-capable hosts (servers and clients), the administration console is
installed when you install NetBackup on the host. For remote administration of
any NetBackup server, specify the server name in the login dialog box.

Installing or removing multiple versions of the NetBackup-Java
Administration Console on Windows

A NetBackup environment may contain servers of various NetBackup versions.
This section describes how install and uninstall multiple versions.

Installing multiple versions of the NetBackup Administration
Console on Windows

A number of methods can be used to administer servers in a mixed-version
environment.

One method is to install a relevant version of the NetBackup-Java
Administration Console on a Windows desktop. Then you can use that console to
administer all servers of the same version.

Note the following points before you install multiple versions of this NetBackup
interface:

m  Only the most recently installed version of the NetBackup-Java
Administration Console can be patched.

m  Only the most-recently-installed version can be removed (uninstalled) with
the standard Windows Add/Remove Programs utility.
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The NetBackup-Java Capabilities Authorization configuration file
(auth.conf), must always be located in install_path\java. For
example, in C: \Program Files\Veritas\java). The file must exist
there regardless of how many versions of the console are installed, or in
which directories they are installed.

The file is only relevant for administering NetBackup on this Windows host,
and default settings exist if the file is not present. The defaults are
discussed in the Veritas NetBackup Administrator’s Guide for Windows,
Volume I, in the section on how to authorize NetBackup-Java users.

When you install multiple versions of the NetBackup-Java Administration
Console in a mixed environment, you must do the following:

Provide a unique string for the host name when asked (pre-6.0 versions).

Install each Java console version to a different folder.

Note: The NetBackup-Java Administration Console for the Windows platform is
not installed automatically.

To install earlier versions of the NetBackup-Java Administration Console

1

Insert the NetBackup Windows installation CD with the version of the
NetBackup-Java Administration Console you want to install.

Select one of the following consoles, based on the NetBackup version:

m  For NetBackup 5.0 installations, select NetBackup Installation and click
Install Java Administration Console.

m  For NetBackup 5.1 installations, select NetBackup Installation and click
Java Windows Display Console. Select whether you want to install the
32-bit or the 64-bit console.

m  For NetBackup 6.0 installations, select NetBackup Installation and click
Install Java Administration Console. Select whether you want to install
the 32-bit or the 64-bit console.

If a different version of the Java console has already been installed, specify a
different folder location to prevent overwriting the earlier installation.

For example, specify C: \Program Files\Veritas\nbjava50 for
version 5.0 Java consoles.

The wizard asks you to enter the name of the host you want to manage. For
ease of use, instead of entering a host name, enter a name that reflects the
version of the console being installed. For example, 5. 0GA.

After the installation, the host name you entered appears in the following
locations:
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m  Asthe default host name in the login screen of the NetBackup-Java
Administration Console dialog box.
The descriptive host name appears here only the first time the console
is opened. After you change the name to an actual host name in the
login dialog box:

m Login to the console.

m  Exit from the console.

The actual host name becomes the default and appears the next time
the console is started.

m  On the Veritas NetBackup menu (Start > Programs > Veritas
NetBackup > NetBackup-Java Version 6.5 host_name).

m  As adesktop shortcut icon.

Removing earlier versions of the NetBackup-Java
Administration Console on Windows

If you want to remove earlier versions of the NetBackup-Java Administration
Console, you do not run Add/Remove Programs.

To uninstall earlier versions of the NetBackup-Java Administration Console

1 Remove the folder where the earlier version NetBackup-Java Administration
Console is installed.

2 Remove the appropriate menu item from the Start > Programs > Veritas
NetBackup menu.

3 Remove any relevant desktop shortcuts.

About the Java Windows Administration Console

Skip this section if you do not want to administer your UNIX NetBackup servers
remotely, with the Java Windows Administration Console on a Windows
platform.

The Java Windows Administration Console lets you run the NetBackup Java
Administration Console for UNIX interfaces on supported Windows platforms.
This interface provides the same capabilities as the NetBackup Administration
Console for Windows or UNIX.
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Installing the Java Windows Administration Console

Use the following guidelines when you install the Java Windows Administration
Console:

You can install the Java Windows Administration Console from the
NetBackup CD for Windows.

If you use NetBackup Access Control, the Symantec Product Authentication
and Authorization client components must be installed on the Windows
host before the Java Windows Administration Console. This order of
installation ensures that the Java Windows Administration Console uses the
Symantec Product Authentication and Authorization components correctly.

For the computer on which you want to run the Java Windows
Administration Console, you should have at least 512 MB of physical
memory.

To install the NetBackup Java Windows Administration Console

1

On the machine where you perform the installation, insert the CD that
contains NetBackup server software for Windows.

On Windows systems with Autorun enabled, the installation starts
automatically.

On Windows systems with Autorun disabled, navigate to the CD directory
and run Launch. exe.

On the initial screen, select NetBackup Installation.

On the Installation screen, select Install Java Windows Administration
Console.

On the Welcome screen, click Next.
On the License Agreement screen, accept the agreement and click Next.

On the NetBackup Installation Type screen, select Install to this computer
only and Typical.

On the Ready to Install the Program screen, click Install.
On the System Validation Complete screen, click Finish.

You can open the NetBackup-Java Windows Display Console by choosing
Start > Programs > Veritas NetBackup > NetBackup Java version 6.5.

Administering multiple versions of NetBackup servers

You can use one of the following methods to administer earlier versions of
NetBackup. The order of the listed methods does not imply any preference.
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Earlier versions of the NetBackup-Java Administration
Console on UNIX platforms

Use the earlier versions of the NetBackup-Java Administration Console installed
on the supported UNIX platform(s). The earlier versions available in a release
are all of those supported in a mixed version environment with the current
release. For example, all versions back to and including the last major release. In
the NetBackup 6.5 release, the 6.0, the 5.0MP4 (or later), and the 5.1 console
versions are available.

Earlier versions of the NetBackup-Java Administration
Console on Windows platforms

Use the earlier versions of the NetBackup-Java Administration Console installed
on the supported Windows platforms.

To install multiple versions of the NetBackup-Java console, see “Installing
multiple versions of the NetBackup Administration Console on Windows” on
page 43.

Remote display-back from UNIX servers

Use the UNIX remote display-back capabilities for UNIX servers that can run
NetBackup-Java, possibly with tools such as Exceed or VNC.

Remote display-back from Windows servers

Use the NetBackup Administration Console for Windows with the remote
display-back capabilities on Windows NetBackup servers with tools like
Windows Terminal Services or Remote Desktop.

At the console of the server with an earlier version of
NetBackup

Use the relevant NetBackup-Java Administration Console from the console of
the server with the earlier version of NetBackup.
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Upgrading NetBackup

This chapter includes the following topics:
m  “Requirements for upgrades to NetBackup 6.5”
m  “Upgrading NetBackup on UNIX servers and clients”

m  “Completing your system update after an upgrade”

Requirements for upgrades to NetBackup 6.5

NetBackup version 6.5 includes many new features. Some new upgrade
requirements have been put in place to make your transition to this version of
NetBackup easier.

The following describes the requirements for NetBackup server upgrades:

m  Always back up your NetBackup databases before upgrading NetBackup
software on the master server.

m  You can upgrade to NetBackup 6.5 only if you have one of the following
versions currently installed:
m Version 6.0
The procedure for upgrading from 6.0 to 6.5 is included in this
installation guide.
m  Notes about logging changes when upgrading to NetBackup 6.5
An upgrade to NetBackup 6.5 overwrites the nblog. conf file with
anew file and resets two logging settings.
The Logging Level feature was introduced in NetBackup 6.0 GA.
Upgrading to 6.5 resets this feature to 1. To change the Logging
Level to the desired setting after upgrading, refer to the Veritas
NetBackup Administrator’s Guide, Volume I.
The LogRecycle feature was introduced in NetBackup 6.0 MP4.
Upgrading to 6.5 resets this feature to OFF. To change LogRecycle
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to the desired setting after upgrading, refer to the Veritas
NetBackup Troubleshooting Guide. You should also refer to the
information at the following Website:
http://entsupport.symantec.com/docs/279590

m  Version 5.0MP4 (or later) or version 5.1

The procedures for upgrading from 5.0MP4 (or later) or version 5.1 are

not included in this guide.

Before you can upgrade from 5.0MP4 (or later) or version 5.1, you must

first prepare your current NetBackup environment for an upgrade to

version 6.5. The upgrade instructions can be found as follows:

m  Go to the following Symantec Website:
http://entsupport.symantec.com

m  Inthe Product Lookup dialog box, enter NetBackup Enterprise
Server and click on the arrow to the right.
The next page that displays includes a Hot Topics section that
provides a link to an upgrade portal.
Following the procedures described in the linked documents at this
Website help ensure a successful upgrade.

Note: If you have a version earlier than 5.0MP4 installed (such as 4.5),
you cannot upgrade directly to NetBackup 6.5. You must first upgrade
to NetBackup 5.x and then upgrade to NetBackup 6.5.

Review the “Requirements for NetBackup server installation” on page 13
before upgrading NetBackup. Many of these requirements apply to
NetBackup upgrades.

A master server cannot be changed to a media server when you perform an
upgrade. To make this change, you must first uninstall the earlier version of
NetBackup, then perform an installation of the new version.

For NetBackup Enterprise upgrades:
m  Youcannot convert an existing non-failover server to a highly available

failover NetBackup server.

Make sure that the NetBackup version on each server is at least equal to the
version installed on any clients. Earlier server software versions can
encounter problems with later client software versions.

Add-ons must be at the same version as the NetBackup server or client
where the add-on is installed.

To use the access control features in NetBackup 6.5, you must install the
Symantec Product Authentication and Authorization components.
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If access control is already installed in your current NetBackup
environment, you must install the new Symantec Product Authentication
and Authorization components before you upgrade to NetBackup 6.5.

For NetBackup access control installation and upgrade instructions, see the
Veritas NetBackup Security and Encryption Guide.

If you have NetBackup 5.0 and earlier clients that are unsupported for
NetBackup 6.5, you may encounter problems with new features in this
release. Move those earlier version clients to a separate policy.

Ensure that the gzip and the gunzip commands are installed on the local
system. The directories where these commands are installed must be part of
the root user’s PATH environment variable setting.

NetBackup Operations Manager (NOM) considerations

NOM is not an incremental update to any existing Symantec products. Any
NetBackup Global Data Manager (GDM) and NetBackup Advanced Reporter
(NBAR) installations cannot be upgraded to NOM installations. There are
substantial differences and enhancements in the architecture, design,
implementation, data model, and historical data from GDM or NBAR in
previous NetBackup versions.

If you have installed any NetBackup versions earlier than 6.5 that have
NBAR or GDM, you must uninstall NBAR and GDM from your server
completely. Only then can you upgrade to NetBackup 6.5.

Upgrade requirements for Solaris systems

The installation procedure prompts you for the name of an alternate root
path. This path is used in an alternate boot environment that lets you install
NetBackup on a different server.

For example, assume that Host B’s root, usr, and var file systems are
mounted on Host Aas /alt, /alt/usr, and /alt/var. When logged in to
Host A, you can specify /alt as the alternate root environment and install
NetBackup on Host B. This feature applies only to NetBackup Server, and
not to optional products or agents.

Upgrade requirements for clustered environments

Refer to the Veritas NetBackup High Availability Administrator’s Guide for
cluster installation prerequisites and notes, specific to your cluster
environment. This installation guide describes cluster installation, but may
not provide details for your particular configuration.
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An existing non-failover NetBackup server cannot be converted to a highly
available failover NetBackup server.

Before you upgrade, you must have the cluster frameworks installed,
configured, and started.

Cluster environments are only supported with NetBackup Enterprise Server.

The name you enter during the upgrade for the NetBackup server is the
virtual server name, not the actual local host name.

Make sure that each node in the cluster where you install NetBackup can run
the rsh command or its equivalent. (On HP-UX, the command is remsh). As
the root user you must be able to perform a remote login to each node in the
cluster without entering a password. Remote login without a password is
only necessary for installation and configuration of the NetBackup server,
and any NetBackup agents and options. After installation and configuration
are complete, it is no longer required.

The virtual server name must be defined using DNS, NIS, or /etc/hosts.
The IP address is defined at the same time. (The virtual name is a label for
the IP address.)

The CLUSTER_NAME must be exactly the same in each bp. conf
configuration file. This requirement ensures that the device configuration
information for each cluster node in the EMM database is stored properly.
Otherwise, the upgrade may not detect all of the nodes in the cluster.

Upgrading NetBackup on UNIX servers and clients

This section describes how to upgrade NetBackup from previous versions, or
from NetBackup Server to NetBackup Enterprise Server. It also describes how
this version can handle the media servers that use different versions of
NetBackup.

After you insert the appropriate NetBackup CD or DVD into your computer, the
installation process searches to determine if an earlier NetBackup version exists
on your system. The presence of an existing version of NetBackup dictates that
you are about to perform an upgrade.

When you upgrade from NetBackup 6.0 to 6.5, Symantec recommends the
following order:

Master server
Media server
NetBackup Remote Administration Consoles

NetBackup clients
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m  Any NetBackup add-on products

Allowing for Reinstallation of Earlier Versions of NetBackup

If you ever intend to reinstall a previous version of NetBackup after you have
performed an upgrade, backups are essential. If you need to reinstall, these
backups contain your most recent data.

Note: For clustered environments: You cannot reinstall an earlier version of
NetBackup.

To allow for reinstalling earlier versions of NetBackup

1 Back up all databases (media, volume, configuration, device) and catalogs on
the master and remote media servers.

2 Back up all NetBackup patches, scripts, and bp . conf entries that are
specific to the earlier version of NetBackup.

You do not have to upgrade your clients at this time; only the master and remote
media servers.

Upgrading server software from version 6.0

Use the following procedure to upgrade NetBackup server software from 6.0 to
6.5.

To upgrade server software from version 6.0 to 6.5

Note: If you currently have NetBackup access control 6.0 installed, you must
upgrade that product before you upgrade to NetBackup 6.5. For access control
upgrade instructions, see the Veritas NetBackup Security and Encryption Guide.

1 Logon as the root user on the server.
2 Deactivate all policies.
For NetBackup Administration Console users:
m  Open the NetBackup Administration Console on the master server.
m  From the tree on the left, select Policies.
m In the right pane, select all of the policies that appear.

m  Right-click the polices, then select Deactivate.
For command-line users, enter the following command:

/usr/openv/netbackup/bin/admincmd/bpplinfo \
policy _name -modify -inactive
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Deactivate disk staging storage units.

For NetBackup Administration Console users:

m  Open the NetBackup Administration Console on the master server.

m  From the tree on the left, expand NetBackup Management > Storage
Units.

m In the right pane, double-click on a disk staging storage unit.

m  When the Change Storage Unit window appears, select Staging
Schedule.

m  When the Disk Staging Schedule window appears, click on the Exclude
Dates tab.

m  Select the date in the calendar that matches the date of the system
upgrade.

m  Repeat these tasks for each disk staging storage unit.

For command-line users, enter the following command:
/usr/openv/netbackup/bin/admincmd/bpschedulerep \
schedulename -excl mm/dd/yyyy

Deactivate all media servers.

For NetBackup Administration Console users:

m  Open the NetBackup Administration Console on the master server.

m  From the tree on the left, select Media and Device Management >
Devices > Hosts.

m Inthe right pane, select all of the media servers that appear.
m  Right-click the media servers and select Deactivate.

For command-line users, enter the following command:
/usr/openv/volmgr/bin/vmoprcmd -deactivate_host -h \
device_host

For clustered environments:

m  Freeze the NetBackup Group so that migrations do not occur while the
inactive nodes are upgraded. If you have a VCS cluster configured, you
can freeze the NetBackup Group by using the Cluster Manager
interface or the command line.

For Solaris systems:

Warning: All of the NetBackup scripts that you may have modified are
removed when you complete this step. You may want to save any files that
you have modified and want to keep, before you perform this step.

m If it exists, remove the following file:

rm -f /usr/openv/netbackup/bin/driver/snapctll0_x
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m  Remove the current NetBackup server package as follows:
pkgrm VRTSnetbp
You see the following prompt:

Are you doing this pkgrm as a step in an upgrade process?

m  Answer y (yes).

For AIX systems:

Note: This step deletes any robotic control paths. For more information
about the robotic control paths, see the Veritas NetBackup Device
Configuration Guide.

Uninstall the ovpass driver, as follows:

/usr/openv/volmgr/bin/driver/remove_ovpass

Note: In an AIX clustered environment, you must run this step on all nodes
in the cluster.

Ensure that you have license keys for all the NetBackup servers, clients,
options, and agents that you ordered.

Note: NetBackup Enterprise only: When you install a master or a media
server, you must enter a NetBackup Enterprise server license key.

For more information on how to administer NetBackup licenses, see the
Veritas NetBackup Administrator’s Guide, Volume L.

Insert the appropriate NetBackup Server CD or DVD in the drive.

For instructions on how to mount the CD or DVD on your operating system,
refer to the appropriate section of “Mounting the software media” on

page 21. For information on CD and DVD contents, refer to “Contents of the
NetBackup media kit” on page 10.

Run the installation script, as follows:

cd_directory/install

The cd_directory is the path to the directory where you can access the CD or
DVD. On some platforms, it may be necessary to mount the directory.

When the following message appears, update PBX.

The following package(s) need to be updated before
NetBackup can be installed:

VRTSpbx

The listed package(s) are part of the Symantec
Infrastructure Core Services (ICS) CDs/DVDs which are
included in the corresponding NetBackup media kit.
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To upgrade PBX from a CD:

Use the displayed instructions as follows:

B From a different window, unmount/eject the NetBackup
cdrom and insert/mount the ICS cdrom. Make sure the
ICS CD has been properly mounted and files are
visible.

B Enter the full path name to the directory where the
appropriate installics script is located followed by a
<CR> to continue. This script will then install the
package(s) .

To upgrade PBX from a DVD:

Use the displayed instructions as follows:

B The ICS image is contained on the currently mounted
media at:
dvd_directory/mounted ICS location
Do you want to install the listed package(s) now?
ly,n] (vy)

m Press Enter to upgrade PBX from the mounted DVD.

12 Follow the prompts in the installation script to install the NetBackup server

binaries.
For clustered environments:

m  Upgrade the inactive nodes first, then upgrade the active node.

Note: During the upgrade, you see the following prompt:

Do you want to start the NetBackup bprd process so
backups and restores can be initiated? [y,n] (y)

If you accept the default (type y or press Return), backups and restores can
be initiated after the upgrade is completed. However, any active policies
from the earlier NetBackup version may be used by the new version of
NetBackup. A backup or restore operation may start while you try to
configure NetBackup.

You should schedule your upgrade and reconfiguration for a time when
backups do not run. You can also temporarily modify policies so that jobs do
not run while you reconfigure NetBackup.

If you type n in response, the daemons are not started and you must start
bprd and 1tid before you can run NetBackup.
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13 Optional step to upgrade clients:
During the upgrade, the correct NetBackup client software is automatically
installed on the server. To install additional client software on your current
server, you can mount the appropriate client CD or DVD and run that
installation script.
Each client CD or DVD installation script lets you load the client software on
the server for each of the UNIX client types that NetBackup supports. You
can then “push” this client software from the server to your UNIX clients.
For information on how to upgrade clients, refer to “Upgrading clients after
servers are upgraded” on page 57.

14 For clustered environments only.
Unfreeze the NetBackup group.

15 After you have finished the upgrade of NetBackup, you can install and
configure NetBackup access control. For detailed information, see the
Veritas NetBackup Security and Encryption Guide.

Upgrading clients after servers are upgraded

The update_clients installation script lets you push client software to
clients. It does not let you push client software to a remote client that is also a
NetBackup media or master server. You cannot push software this way because
the server software and client binaries must be of the same version on a single
host.

The update_clients installation script can determine the full client list that
is configured on the server. When it is run without any parameters, it attempts
to update all clients (as determined by
/usr/openv/netbackup/bin/admincmd/bpplclients). If you do not want
to upgrade all clients, you can specify a subset of clients. Use the hardware type
and operating system parameters or use the -ClientList parameter.

As of NetBackup 6.0, you can run update_clients on a media server. The
-ClientList parameter is required in this situation. The script lets you
maintain a media server and a set of clients at an earlier release level than the
master server. Doing so requires the informed use of the update_clients
-ClientList command on a master server and a media server to avoid
unwanted client upgrades.

To upgrade clients after you have upgraded servers

Note: For clustered environments: You can push client software only from the
active node.
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Mount the appropriate client CD.

Change your working directory to the CD directory if you have a CD or to the
directory that contains the downloaded files:

cd /cd _mount_point

The cd_mount_point is the path to the directory where you can access the
CD.

Enter the following command to run the installation script:
./install

Note: The binaries provided for the client operating system levels represent
the operating system levels on which the binaries were compiled. The
binaries typically function perfectly on later versions of the operating
system. For example, Solaris 9 binaries also are used on the Solaris 10 level
of the operating system. The installation script attempts to load the
appropriate binaries for your system. If the script does not recognize the
local operating system, it presents choices.

Select the client type that you want to load and follow the prompts to install
that client type. Repeat as necessary until all desired client types have been
loaded.

Note: Make sure you load the software for all the UNIX client types you
intend to back up onto the server. Otherwise, you cannot add these client
types to the NetBackup policy configuration.

After the installation is complete, unmount the client CD.

As aroot user on the NetBackup master server, enter the following
command to see whether bprd is running:
/usr/openv/netbackup/bin/bpps

If bprd is running, terminate it with the following command:
/usr/openv/netbackup/bin/admincmd/bprdreq -terminate

Enter the following command to make sure that backups or restores are not
in progress:

/usr/openv/netbackup/bin/admincmd/bpdbjobs

Update UNIX client software by running the update_clients script with
one of the following commands:

Note: Specify the host names of the individual nodes (not virtual names) in the
list of clients.
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Note: The update_clients script does not let you push client software to
remote media or master servers.

m Ifyoudonotusea-ClientList file, run the following command:
/usr/openv/netbackup/bin/update_clients
m Ifyouusea-ClientList file run the following command:

/usr/openv/netbackup/bin/update_clients -ClientList filename

Note: The -ClientList parameter is required on a media server.

Note: For more than 30 clients, you can divide the list into multiple files and
run update_clients for each file.

To create a client list file, perform the following steps:

m  Change to the NetBackup admincmd directory, as follows:
cd /usr/openv/netbackup/bin/admincmd

m Usethebpplclients(1M)command to create afile that contains a list
of clients currently configured in the NetBackup database.
The options to use on this command differ depending on whether you
push from a master server or from a media server, as follows:
m  If you push from the master server, run the following command:

./bpplclients -allunique -noheader > file

m If you push from a media server, run the following command:

./bpplclients -allunique -noheader -M \
m_server_name > file

m_server_name Name of the NetBackup master server in this environment.

file Name of the file to contain the list of unique clients. If no clients have
been configured in the NetBackup database, fileis empty. Create
fileusing the same format as that generated by bpplclients.

The bpplclients command writes output to file in the following
format:
hardware os client

hardware The hardware name. For examples, run the 1s(1) command in directory
/usr/openv/netbackup/client.

0s The operating system name. For examples, run the 1s(1) command in
directory /usr/openv/netbackup/client/hardware.

client The name of the client.
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The contents of file might look like the following example:
Solaris Solaris8 curry
m  (Optional) Edit file.
Perform this step to change the contents of file. Edit file to contain only
those clients you want to update with NetBackup client software.
The host names of the clients must be the clients’ individual node
names. They cannot be virtual names. The correct value for the
individual node names is returned by the hostname(1) and the
domainname(1) commands. The format can be either kostname or
hostname . domainname.

9 Theupdate_clients script requests information from you. The following
information appears in the script:

Starting update_clients script.

There are N clients to upgrade.

Do you want the bp.conf file on the clients updated to list this
server as the master server? (y/n) [y]

Answer either y or n.

Enter the number of simultaneous updates you wish to take
place. [1 - 30] (default: 15):

Press Enter (or Return).

The upgrade will likely take Y to Z minutes.

Do you want to upgrade clients now? (y/n) [vy]

Answer either y or n.

10 After all servers and clients are updated, enter the following command as
the root user on the master server to start the bprd daemon:
/usr/openv/netbackup/bin/initbprd

11 After you have upgraded the NetBackup software, proceed to.“Completing
your system update after an upgrade” on page 61.

Upgrading a NetBackup server to a NetBackup Enterprise Server

When you install NetBackup Enterprise master or media servers, you must enter
a NetBackup Enterprise server product license key. On the master server, you
must also enter license keys for any additional NetBackup software. For
example, any options or agents that are used on the server or its clients.

Note: A NetBackup Server cannot be upgraded to a clustered NetBackup
Enterprise Server. You must perform a new cluster installation of NetBackup
Enterprise Server.




Upgrading NetBackup
Completing your system update after an upgrade

To upgrade a NetBackup server to a NetBackup Enterprise server

1 Ensure that you have license keys for all the NetBackup servers, clients,
options, and agents that you ordered.
For more information on how to administer NetBackup licenses, see the
NetBackup Administrator’s Guide, Volume L.

Note: Anytime you add, delete, or make any other license key updates in the
NetBackup Administration Console, you must restart the console.

2 Reinstall NetBackup, using the instructions from “Upgrading NetBackup on
UNIX servers and clients” on page 52.

3 When prompted, enter the license key.
NetBackup Enterprise software installs.

Completing your system update after an upgrade

After you have upgraded servers and clients, you may need to perform
additional tasks to complete the update of your NetBackup environment.

Required changes after an upgrade
Perform any of the following that apply to your NetBackup environment:

m  If you upgraded a master server that previously allowed nonroot users to
administer NetBackup, you must reconfigure the permissions and group.
The default permissions and group on the newly installed files allow only a
root user to perform NetBackup administration.

m  Upgrade any separately-priced options (such as NetBackup for Oracle) on all
upgraded clients. Separately-priced options should be at the same level as
the NetBackup client.

m If you made changes to NetBackup scripts before the upgrade, apply those
changes to the new, upgraded versions of the scripts.

Automatic file changes from an upgrade

When you upgrade from an earlier NetBackup version, certain files and scripts
are overwritten. Before NetBackup overwrites any file, it appends the version to
the file name and copies the renamed files or scripts to a file or directory.

The following describes the files and scripts that are overwritten when you
upgrade from an earlier version of NetBackup:
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m Allfiles in the /usr/openv/netbackup/bin/goodies directory and the
/usr/openv/netbackup/help directory.

m  Some files and directories in /usr/openv/volmgr.

m  The following scripts from the /usr/openv/netbackup/bin directory:
backup_notify
backup_exit_notify
bpend_notify (present only if used)
bpend_notify busy (present only if used)
bpstart_notify (present only if used)
dbbackup_notify
diskfull_notify
initbpdbm
initbprd
restore_notify
session_notify
session_start_notify
userreq notify
For example, an upgrade from NetBackup 5.1GA to NetBackup 6.5 would
result in the following directory name change:
/usr/openv/netbackup/bin/goodies
The new directory name might be like the following:
/usr/openv/netbackup/bin/goodies.5.1GA
m  The following scripts from the /usr/openv/volmgr/bin/goodies
directory:
drive_mount_notify (present only if used)
drive_unmount_notify (present only if used)

m  The following scripts from the /usr/openv/volmgr/bin directory:
shared_drive_notify

Installing NetBackup Agents and Options After an Upgrade

After your upgrade is complete, you can install any other NetBackup agents and
options (such as NetBackup for Oracle). Follow the instructions that are included
with that product.
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Server Software

This chapter includes the following topics:
m  “Overview of uninstallation”
m  “Uninstalling NetBackup on Solaris servers”

m  “Uninstalling NetBackup on all other UNIX servers”

Overview of uninstallation

This chapter describes how to uninstall NetBackup 6.5 software from your
server system.

During each procedure, you have the opportunity to save any data that you want
and uninstall add-on products before you uninstall NetBackup.

Note: The procedures in this chapter remove NetBackup, any add-on products,
and any databases for those products, including Veritas Storage Migrator.
Symantec recommends that you save the data that you require and uninstall any
add-on products before you uninstall NetBackup.

Uninstalling NetBackup on Solaris servers

This procedure outlines the basic steps that you must perform to remove
NetBackup from a Solaris server. You may also need to reference other
documents for procedures of specific tasks to uninstall NetBackup successfully.

Use the following guidelines when you uninstall NetBackup on Solaris servers:
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The NetBackup package name for versions 6.5 and later is SYMCnetbp. The
NetBackup package name for versions 6.0 and earlier is VRTSnetbp.

If you moved the catalog database files in /usr/openv/db/data to
another location, the uninstall procedure does not remove these files. Refer
to the Veritas NetBackup Administrator’s Guide, Volume I for procedures on
how to remove those files.

For clustered environments: Before you begin to uninstall NetBackup, you
must remove NetBackup from the cluster application. Follow the
instructions in your cluster documentation on how to remove a group, then
you can uninstall NetBackup.

You must uninstall NetBackup from each node in the cluster.

If you identified an alternate root path in your NetBackup 6.5 installation or
upgrade, the process prompts you with the alternate root path. You can use
the pkgrm -R command from the alternate root location.

The pkgrm -R command was implemented starting with the NetBackup 5.0
VRTSnetbp (NetBackup server) package. You cannot use pkgrm -R with
VRTSnetbp packages that were released before NetBackup 5.0. This feature
applies to NetBackup server only, and not add-ons, clients, or database
agents.

When you uninstall NetBackup, PBX is not removed. If you would like to
clean your system permanently, refer to the PBX documentation on your
platform-specific ICS CD.

Warning: Do not uninstall PBX if your server uses other Symantec software
products that require PBX to run.

To uninstall NetBackup from a Solaris server

1
2
3

Log on as the root user on the server.
Perform a catalog backup.

Identify any installed add-on products and ICS Native packages by using the
following command:

pkginfo

Important - Save all important data from any add-on products you have
installed.

For instructions on how to migrate files to a secondary storage device, refer
to the Veritas Storage Migrator Administrator’s Guide.

Uninstall each add-on product and agent.
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Refer to the following sources for the specific procedure that is related to
each add-on product:

Add-on product Uninstallation source

Veritas Storage Migrator Veritas Storage Migrator Installation Guide

NetWare Media Server Veritas NetBackup Media Server Option
Administrator’s Guide

NetBackup Encryption Veritas NetBackup Security and Encryption Guide

NetBackup LiveUpdate Refer to “Uninstalling NetBackup LiveUpdate” on
page 127.

Stop the NetBackup/Media Manager daemons:
/usr/openv/netbackup/bin/goodies/bp.kill_all

If it exists, remove the following file:
rm -f /usr/openv/bin/driver/snapctll0_x

To remove the ICS Native packages, use the pkgrm command. Remove the
packages in the order in which they appear in the following list. You must
follow this order to help prevent a failed package removal.

If any package does not appear on your pkginfo list, skip to the next
package.

Command Description

pkgrm VRTSaz Symantec Product Authorization Service
pkgrm VRTSat Symantec Product Authentication Service
pkgrm VRTSpbx Symantec Private Branch Exchange

Caution: Do not remove VRTSpbx if there are other
Symantec software products installed that require it.

pkgrm VRTSicsco Symantec Infrastructure Core Services Components

To remove the NetBackup package, run the following command:
pkgrm SYMCnetbp

When asked if you want to remove the installed package SYMCnetbp, enter
y and press enter.

When asked if you want to continue with the package removal using
super-user permission, enter y and press enter.
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12

13

14

15

16

17

18

When asked if you want to stop NetBackup and Media Manager processes,
enter y and press enter.

When asked if the package removal is a step in an upgrade process, enter n
and press enter.

When asked if you want to remove any directory in the /opt /openv
directory path that is not empty, enter y and press enter.

When asked if you want to remove references to NetBackup and Media
Manager from services and inetd configuration files, enter y and press
enter.

After a few minutes, you should see the following message:

Removal of <SYMCnetbp> was successful.

Remove the startup scripts, as follows:
rm -f /etc/rc2.d/S77netbackup
rm -f /etc/rc2.d/S95nbclient
rm -f /etc/rcl.d/KOlnetbackup
rm -f /etc/rcl.d/KOlnbclient
rm -f /etc/rc0.d/KOlnetbackup
rm -f /etc/rc0.d/KO0lnbclient
rm -f /etc/init.d/netbackup

rm -f /etc/init.d/nbclient

The following startup scripts appear only if NetBackup Fiber Transport was
enabled on the server.

rm -f /etc/rc0.d/K03nbftserver
rm -f /etc/rc2.d/S21lnbftserver
rm -f /etc/rcl.d/KO03nbftserver
rm -f /etc/init.d/nbftserver

To remove the NetBackup-Java application state data for the root account,
run the following commands:

Warning: Do not insert a space between the slash character (/) and the
period or dot character (.) of “/ .nbjava”. A space between these
characters removes all of your files from the root level and beyond.

/bin/rm -rf /.nbjava

/bin/rm -rf /.java/.userPrefs/vrts

Inform NetBackup-Java users, that they can remove their $HOME/ .nbjava
and portions of $HOME/ . java directories.

The $SHOME/ .nbjava and SHOME/ . java directories contain application
state information, that is saved when the user exits NetBackup-Java
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applications. The saved information includes table column order and size.
The process removes this directory for the root user only.

The common subdirectory in $SHOME/ . java/ .userPrefs/vrts can be
removed.

If you enabled NetBackup access control, NetBackup placed several files on
clients and servers. These files can be divided into two categories:
m  NetBackup application temporary files
These files are removed with NetBackup.
m Individual user (cache) files

Users’ cache files exist in the SHOME/ . vxss directory. Inform all users
that they can remove the SHOME/ . vxss directory.

Note: Files are generated in the /. vxss directory by a single sign-on
operation of the NetBackup Administration Console on the host where the
console runs. The NetBackup Administration Console cleans these files
when an exit function is performed, so the directory does not always
contain temporary files. However, if a system crash were to occur, any files
in the directory may be left behind. With the console shut down, you can
delete these files safely with no data loss.

NetBackup also creates cached certificates for client and server NetBackup
applications. These files reside within the / . vxss directory. These files
typically have a name that is consistent with a DNS entry for a network
interface, as in machine. company. com.

Example directory entries are as follows:
/usr/openv/var/vxss/credentials/machine.company.com
/usr/openv/var/vxss/credentials/dhcp

These files are created with the command bpnbat -LoginMachine. If you
plan to reinstall NetBackup on the same machine at a later date, do one of
the following:

m  Preserve the certificates in the vxss/credentials directory.

m If youdo not preserve the certificates, you must provide the machine
identity password as originally set on the Root+AB broker. As an
alternative, you can reset the password on the Root+AB broker when
you reinstall.

For more information on Root+AB brokers, please see the Veritas
NetBackup Security and Encryption Guide.

Note: For more information on NetBackup access control, including how to
uninstall it, see the Veritas NetBackup Security and Encryption Guide.
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Use the following guidelines when you uninstall NetBackup from UNIX servers
other than Solaris:

If you moved the catalog database files in /usr/openv/db/data to
another location, the uninstall procedure does not remove these files. Refer
to the Veritas NetBackup Administrator’s Guide, Volume I for procedures on
how to remove those files.

For clustered environments: Before you begin to uninstall NetBackup, you
must remove NetBackup from the cluster application. Follow the
instructions in your cluster documentation on how to remove a group, then
you can uninstall NetBackup.

For HP-UX Service Guard Cluster environments: If NetBackup has been
configured to run as a clustered package, you must also delete the
/etc/cmcluster/netbackup directory.

When you uninstall NetBackup, PBX is not removed. If you would like to
clean your system permanently, refer to the PBX documentation on your
platform-specific ICS CD.

Warning: Do not uninstall PBX if your server uses other Symantec software
products that require PBX to run.

To uninstall NetBackup from a UNIX server other than Solaris

1
2
3

Log on as the root user on the server.
Perform a catalog backup.

Stop the NetBackup/Media Manager daemons:
/usr/openv/netbackup/bin/goodies/bp.kill_all

Run the following command to unregister NetBackup from the VxUL master
configuration that is stored in the /etc/vx/vrtslog.conf file:
/usr/openv/netbackup/bin/vxlogcfg -r -p 51216

The -p option specifies the product ID, which is 51216 for NetBackup.

Important - Save all important data from any add-on products you have
installed.

For instructions on how to migrate files to a secondary storage device, refer
to the Veritas Storage Migrator Administrator’s Guide.

Uninstall each add-on product.
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Refer to the following sources for the specific procedure that is related to
each add-on product:

Add-on product Where to find uninstallation details

Veritas Storage Migrator Veritas Storage Migrator Installation Guide

NetWare Media Server Veritas NetBackup Media Server Option
Administrator’s Guide

NetBackup Encryption Veritas NetBackup Security and Encryption Guide

NetBackup LiveUpdate Refer to “Uninstalling NetBackup LiveUpdate” on
page 127.

Remove the NetBackup databases by running the following command:
/usr/openv/db/bin/create_nbdb -drop_only

This command removes the databases even if they have been moved from
their default locations.

Remove the ICS Native packages. For complete details, refer to the Veritas
Infrastructure Core Services Installation Guide for UNIX; “Uninstalling the
ICS”.

To remove references to NetBackup/Media Manager from /etc/services
and the [x]inetd configuration files, run the edit_services script:
/usr/openv/netbackup/bin/goodies/edit_services

To remove the /usr/openv directory, select one of the following methods:

Warning: The rm -f /usr/openv command also removes any add-on
products that are installed on the machine where you perform this
command.

m If /usr/openv is a physical directory, run the following command:

rm -rf /usr/openv

m If /usr/openv is alink, run the following commands:
cd /usr/openv
pwd
1s
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Warning: Before you continue, make sure you are at the correct location and
verify that the subdirectories are what you would expect them to be. To help
prevent removing the wrong directories, the previous commands verify
your current location and list the files in that directory. After you verify the
directory location and its contents, remove the directory with the next
commands.

rm -rf *
cd /

rm -f /usr/openv

11 For Linux systems only:
If you modified the startup and the shutdown scripts as described in
“Configuring NetBackup Startup and Shutdown” on page 99, run the
following command:

/sbin/chkconfig --del netbackup

12 Remove the following links and files:

System Path

AIX /etc/rc.netbackup.aix
/etc/rc.client.netbackup

Alpha Tru64 /sbin/rc3.d/S77netbackup
/sbin/rc0.d/K0lnetbackup
/sbin/init.d/netbackup

HP-UX /sbin/rc2.d/S777netbackup (note three 7s)
/sbin/rcl.d/K001lnetbackup
/sbin/init.d/netbackup
/sbin/rcl.d/K001lnbclient
/sbin/rc2.d/S951nbclient
/sbin/init.d/nbclient
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System

Path

Linux Red Hat

/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.

The following startup scripts appear only if NetBackup
Fiber Transport was enabled on the server:

/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc.

d/init.d/netbackup

d/rc0
d/rcl
d/rc2
d/rc3
d/rch
d/rcé

.d/KO0lnetbackup
.d/KOlnetbackup
.d/S77netbackup
.d/S77netbackup
.d/S77netbackup
.d/KO0lnetbackup

d/init.d/nbclient

d/rc0
d/rcl
d/rc2
d/rc3
d/rc5
d/rcé

.d/KOlnbclient
.d/KOlnbclient
.d/S95nbclient
.d/S95nbclient
.d/S95nbclient
.d/KOlnbclient

d/init.d/nbftserver

d/rc2
d/rc3
d/rc5
d/rc0
d/rcl
d/rcé

.d/S21lnbftserver
.d/S21lnbftserver
.d/S21lnbftserver
.d/K03nbftserver
.d/K03nbftserver
.d/K03nbftserver

Linux SuSE

/etc/init.

d/netbackup

/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.

d/rc0
d/rc2
d/rc3
d/rc5
d/rcé

.d/KO0lnetbackup
.d/S77netbackup
.d/S77netbackup
.d/S77netbackup
.d/KO0lnetbackup

d/nbclient

d/rc0
d/rc2
d/rc3
d/rc5
d/rcé

.d/KOlnbclient
.d/S95nbclient
.d/S95nbclient
.d/S95nbclient
.d/KOlnbclient
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13

14

15

System Path

Other servers /etc/rc2.d/S7Tnetbackup
/etc/rcl.d/K0lnetbackup
/etc/rc0.d/K0lnetbackup
/etc/init.d/netbackup
/etc/rc2.d/S95nbclient
/etc/rcl.d/KO0lnbclient
/etc/rc0.d/KO0lnbclient
/etc/init.d/nbclient

The following startup scripts appear only if NetBackup
Fiber Transport was enabled on the server:

/etc/rc0.d/K03nbftserver
/etc/rc2.d/S21nbftserver
/etc/rcl.d/K03nbftserver
/etc/init.d/nbftserver

For AIX systems only:

Remove the NetBackup /etc/rc.netbackup.aix entry from the
/etc/inittab file.

Remove the line /etc/rc.netbackup.aix stopin the
/etc/rc.shutdown file.

Run the following commands to remove the NetBackup-Java application
state data for the root account:
/bin/rm -rf /.nbjava

/bin/rm -rf /.java/.userPrefs/vrts

Inform NetBackup-Java users, that they can remove their $SHOME/ .nbjava
directory.

The $HOME/ .nbjava and $HOME/.java directories contain application
state information, that is saved when the user exits NetBackup-Java
applications. The saved information includes table column order and size.
The process removes this directory for the root user only.

The common subdirectory in $SHOME/ . java/.userPrefs/vrts can be
removed.
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This chapter includes the following topics:
m  “NetBackup license compatibility”
m  “Entering license keys”

m  “Frequently asked questions”

NetBackup license compatibility

To use your current NetBackup license keys to upgrade your servers, add-on
products, and database agents to NetBackup 6.5, you must have the following:

m  NetBackup 5.x or 6.0 currently installed

m A valid maintenance contract for all licensed NetBackup products

Note: You cannot upgrade to NetBackup 6.5 if your current installed version is
NetBackup 4.5. You must first upgrade to NetBackup 5.x, and then you can
upgrade to NetBackup 6.5.

Upgrade licenses and software may be obtained from the Symantec Licensing
Portal at the following Web site:

https://licensing.symantec.com/acctmgmt/index.jsp

For detailed information and procedures on how to administer license keys,
refer to the NetBackup Administrator’s Guide.

Entering license keys

The easiest method for entering license keys is to enter all of them when you
install NetBackup on a master server.


https://licensing.symantec.com/acctmgmt/index.jsp
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After you install NetBackup, you can open the NetBackup Administration
Console and select Help > License Keys...

On UNIX servers, you can also run the following command:
/usr/openv/netbackup/bin/admincmd/get_license_key

Note: All product license keys must be entered on the master server.

For some features and products, license keys must also be installed on the media
server. The following features require license key installation on media servers
and master servers:

m  NetBackup SharedDisk
m Library-based Tape Drives Feature

m NDMP

Note: You can log in to a NetBackup server from almost any server in a system to
view, enter, and administer license keys. When you administer license keys
remotely, ensure that you view the licenses of the system you intend to change.
You do not want to add or change a license key on the wrong server.

Frequently asked questions

Symantec customers have asked the following questions about how to manage
license keys.

Is the license system for NetBackup the same as the license system in other Symantec
products?

NetBackup uses a common license system that other Symantec products also use. Please
remember, however, that the common license system provides flexibility in the license
features that each product implements. For example, NetBackup does not have a
node-locked license system, but some other products do.

Can | use NetBackup if all | have is a media/doc kit?

No. The media/doc kit by itself does not allow any access to NetBackup. You always need a
license key (either permanent or evaluation). License keys should always be delivered with
the media/doc kit, so you should never find yourself with a media/doc kit and no key.

What does the license key look like? What information does it contain?

The key is a multi-digit alphanumeric string (for example:
8EPP-ABCD-9XYZ-XYZ9-8881-VCF4-0IUF-AJDC). The key contains information on the
following:

m  Whether the key is for NetBackup Server or NetBackup Enterprise Server

m  Whether the key is for a server, a client, an agent, or an option (and which one)

B Whether the key is a permanent key or an evaluation key
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m  Information about how and where the key was generated

Is the license key serialized?
Yes, serialization information is embedded in the key.

Can | see reports on what license keys | have?

Yes. Information about license keys is stored on the master server.

To access the information, open the NetBackup Administration Console and select Help >
License Keys....

On media servers, enter the master server name as the host name on the login screen.
On UNIX servers, you can also run the following command:
/usr/openv/netbackup/bin/admincmd/get_license_key

For more information on how to view reports, refer to the NetBackup Administrator’s
Guide.

How do | enable options and agents?

When you install NetBackup, you are prompted to enter the license keys for all options and
agents.

If you purchase an agent or other add-on product at a later date, you can enter its license
key manually. Open the NetBackup Administration Console and select Help > License
Keys....

On media servers, enter the master server name as the host name on the login screen.

On UNIX servers, you can also run the following command:
/usr/openv/netbackup/bin/admincmd/get_license_key

Many options and agents require that you have your original NetBackup CDs, because
additional binaries must be installed. You should always keep your NetBackup CDs in a safe
place.

Should I save license keys after they have been entered?
Yes. Always store copies of your license keys in a secure place.

What should I do if | have lost my license key(s)?

Symantec has a record of all license keys that are issued to customers. Customers who lose
their license key(s) can call Order Management to get copies of their license keys.

For Americas, Japan, PacRim, Australia:

Tel: 650.318.4265 FAX: 650.335.8428

For Europe, Middle East and Africa:
Tel: 00.353.61.365232 FAX:00.353.61.365223

If you have purchased NetBackup from a Symantec partner, you need to contact that
partner for information on your key.

How are large volume orders handled?

Many NetBackup installations are very large, and the license keys are long. License keys
that you enter multiple times can be time-consuming. You can request a single license key
for each type of NetBackup component you purchase. For example, you can obtain one
license key for use with 50 Oracle agents. Site licenses enable unrestricted use for specific
NetBackup agents or options.
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Note: You still need a unique license key for each type of NetBackup component that you
purchase. Separate license keys are required for a NetBackup server, a Lotus Notes agent,
an NDMP option, a UNIX client, and so on.

What about license keys for customers with site licenses?
Site licenses are handled much like large volume orders are. The certificate for a site
license states that the license key is good for unlimited copies.

Do | need a license key to enable NetBackup Remote Administration Consoles?
No. NetBackup Remote Administration Consoles do not require special license keys. You
can install them on any computer with access to the master server.

Can a license key be used multiple times?

Yes. You can use your license keys multiple times. You are, however, legally bound to install
and use only the number of NetBackup servers, clients, agents, and options for which you
purchase licenses.

How do existing customers get license keys?

All NetBackup customers who have current maintenance contracts with Symantec
automatically receive the latest version of NetBackup. You receive the NetBackup
media/doc kit and license keys for every component for which you purchased licenses.
If your maintenance is through a Symantec partner, you upgrade through the partner.
Contact the partner for more details.

What if | do not get the right license keys?
If you believe that you received an incorrect license key, contact Order Management using
the number on your license key certificate.

Note: Technical Support does not issue permanent license keys. You can obtain license
keys only through Order Management. Technical Support can provide temporary
one-month license keys to you while issues regarding permanent license keys are
resolved.

What does an evaluation license key enable?

The evaluation license key enables unrestricted use of NetBackup, its agents, and its
options for a predetermined period of time.

Am | notified when an evaluation is about to expire?

To find out when a license key expires, open the NetBackup Administration Console and
select Help > License Keys....

On media servers, enter the master server name as the host name on the login screen.
On UNIX servers, you can also run the following command:
/usr/openv/netbackup/bin/admincmd/get_license_key

What happens when an evaluation license key expires?

The NetBackup daemons are shut down. When you attempt to use the product you are
informed that its evaluation period has expired.
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Does NetBackup save the backup configuration and catalog information when evaluation
license keys expire?

Yes. Customers who add a permanent license key to an evaluation version of NetBackup
have immediate access to their catalog information and configuration information.

How do | upgrade from an evaluation license to a permanent license?

It is easy. When you purchase a permanent license, you add that license to NetBackup. All
the configuration information and catalog data from your evaluation version is retained.
To enter your permanent license key, open the NetBackup Administration Console and
select Help > License Keys....

On media servers, enter the master server name as the host name on the login screen.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key
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Installing clients

This chapter includes the following topics:
m Installing Microsoft Windows clients

m Installing UNIX clients

Installing Microsoft Windows clients

By definition, your NetBackup server is also a NetBackup client. When you
install the NetBackup server software, you install both the NetBackup server
and the NetBackup client software on the server.

Client installation overview

The NetBackup client installation program for Microsoft Windows lets you
select the appropriate setup and installation options from a series of wizard
screens. After you select options, the installation program displays a window
that lets you verify your selections before you continue with the actual
installation.

While the installation is in progress, a dialog box provides details of the
installation and the setup progress. When complete, a final window shows the
installation results.

Note: You cannot install NetBackup client software on PCs that currently have
NetBackup server software. In these cases, you must first uninstall the
NetBackup server software. See the NetBackup Installation Guide for Windows.

Veritas volume snapshot provider on Windows

If you install the client software on a Windows client, during the installation
process you have the option to install Veritas Volume Snapshot Provider (VSP).



80

Installing clients

Installing Microsoft Windows clients

VSP establishes a point-in-time view, or snapshot, of the data that is selected for
backup on the volumes (or drives). NetBackup then backs up the selected files as
they exist at the time of the snapshot, regardless of file system activity. VSP
uses a file system cache to store the changes that occur during the backup. Each
volume for which a snapshot is created has a corresponding VSP cache file.

For information on the VSP parameters, please refer to the NetBackup
Administrator’s Guide.

User-directed operations for Windows systems

By default on Windows 2000/XP/2003 Server systems, the Program Files
folder is not writable by users other than the administrator.

NetBackup writes log files and progress files to the folder
Program Files\VERITAS\NetBackup\Logs.

To perform backups and restores with the Backup, Archive, and Restore
interface, users must have write permission to the Logs directory. Users
without write permission to this directory receive an error message, and the
backup or restore is canceled. The administrator account has write permission
by default, but you must ensure that users other than the administrator have
write permission.

Local and remote installations for Windows systems

You can use the NetBackup client installation program in the following ways:

m Local installations
The installation program installs the client software only on the machine
where you start the installation.

m  Remote installations
The installation program scans the network for available clients where you
can install the client software. The source machine (the primary node in
cluster environments) must run Windows 2000/XP/2003 Server. In
addition, a remote installation requires system administrator privileges and
is only available for Windows 2000/32-bit XP/32-bit 2003 Server.

Note: You cannot install remotely from UNIX systems to
Windows 2000/XP/2003 machines.

Silent installations for Windows systems

A silent installation is a process that does not require interactive input. It does,
however, require that you edit the silentclient.cmd file before you run the
file.
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New and upgrade installations for Windows clients
The NetBackup Client Setup Wizard recognizes the following types of

installation:

m New installations

The wizard does not detect that any NetBackup client software is currently

installed. You can specify where you want the client software installed.

m  Upgrade installations

The wizard detects that a version of NetBackup client software already
exists. You cannot change the installation location of the client software.

For new or upgrade installations, you can select one of the following types:

m  Typical installation

The wizard uses default settings that should work for most installations.
You must provide the client, master, and additional server names.

m  Custom installation

The wizard lets you change the custom configuration options as needed for
your specific environment. These options are then used for all new client

installations.

You must also provide the client, master, and additional server names.

The custom configuration options are divided among three wizard windows:
NetBackup Client Features, NetBackup Options, and NetBackup Services.

The following table describes the custom configuration options that you can
select for new or upgrade installations.

NetBackup Client
Features window

NetBackup Options
window

NetBackup Services
window

NetBackup Documentation

Start the NetBackup Client
Service automatically (at
system startup)

Use the built-in system
account or specify custom
user name, password, and
domain.

Veritas Snapshot Provider
(VSP)

Start the NetBackup Client
Job Tracker automatically
(at system startup)

Terminate NetBackup
processes (at system
startup)

NetBackup Debugger
Symbols

Start the NetBackup Client
Service on the client after
installation is complete

Terminate Windows
processes (at system
startup)

Change the bpcd, bprd,
vnetd, and vopied port
numbers

Abort install if reboot is
required
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Windows client system requirements

This section describes the hardware and the software requirements for
successful installation of NetBackup client software.

Local installation requirements

To install NetBackup client software locally, the system must meet the following
configuration requirements.

m  Microsoft Windows 2000/XP (32- and 64-bit/2003 Server (32- and 64-bit)
m  An Intel Pentium or Itanium processor
m Internet Explorer 5.5 or later

m  Any TCP/IP transport that is Windows Sockets compliant. (Use of the
TCP/IP transport that comes with the server or the operating system is
recommended.)

m A network adapter that your TCP/IP transport supports

Remote installation requirements

To install NetBackup client software remotely, the system must meet the
following configuration requirements:

m  All the requirements for local installations must be met.
m  The source system must run Windows 2000/2003 Server.

m  The destination system must run Windows 2000/32-bit XP/32-bit 2003
Server.

m  Administrator privileges are required for the person that performs remote
installations.

NetBackup server requirements for Windows clients

The version of the NetBackup server software must be the same or newer than
the version you install on the client.

Installing Windows clients locally

Follow these instructions to install the NetBackup client software on your local
Windows system. You can stop the installation process at any time by clicking
Cancel or by clicking Back to return to the previous window.
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Note: After client installation, you may need to reboot the system for the
changes to take effect.

To install NetBackup client software locally on Windows systems

1
2

N o o b~ w

Log in as administrator on the host or system server.

Insert the NetBackup installation CD in the drive.
On systems with Autorun enabled, the installation starts automatically.

If Autorun is not enabled, navigate to the CD drive and double-click
Launch.exe.

On the initial screen, select NetBackup Installation.

On the installation screen, select Install Client Software.

On the Welcome screen, click Next.

On the License Agreement screen, accept the terms of the agreement.
On the Installation Type screen, select the following:

m Install to this computer only

m  Either Typical or Custom installation.

m  For typical installations, NetBackup uses the default port numbers
and default service startup settings.

m  For custom installations, NetBackup lets you set service startup
settings, change port numbers, and specify the installation
location. You can also choose whether to install NetBackup
documentation, debug symbols, and VSP.

Click Next.

On the NetBackup System Names screen, provide the following information:

Client Name Enter the name of the client machine on which you are logged
in.

Master Server Name Enter the master server name here.

Additional Servers  Enter all the server names that you want this client to access.
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LiveUpdate m  Install LiveUpdate Agent

To install the LiveUpdate agent, leave the check box
checked. Otherwise, click the check box to remove the
check to prevent agent installation.

m  Location of LiveUpdate Server
Enter the network path for the NetBackup LiveUpdate
server here.

m  Server Type
Select the type of server (LAN, HTTP, or HTTPS) used for
the NetBackup LiveUpdate server.

9 On the Ready to Install screen, click Install.

10 On the System Validation Complete screen, click Finish.

Installing Windows clients remotely

Use the following procedures to install NetBackup clients on your network (one
of these clients can be your local system). You can stop the installation process
at any time by clicking Cancel.

Note: Review the installation “Windows client system requirements” on page 82
for remote installations before you start this procedure.

Notes on Windows client remote installations

m During installation, the client name is written to the registry in lowercase.
For backups to work, the policies on the NetBackup server must specify the
client names in lowercase.

®  You must have administrator privileges on the remote client for the
NetBackup install to complete successfully.

m  The NetBackup client installation program cannot clean up after a canceled
installation. If you interrupt the installation, any files that were successfully
installed remain installed on the clients.

m  You may need to reboot your PC or the remote systems for the changes to
take effect.

To install the Windows NetBackup client software on remote computers

1 Login as administrator on the Windows system.

Insert the NetBackup installation CD in the drive.On systems with Autorun
enabled, the installation starts automatically.
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If Autorun is not enabled, navigate to the CD drive and double-click
Launch.exe.

On the initial screen, select NetBackup Installation.

On the installation screen, select Install Client Software.

On the Welcome screen, click Next.

On the License Agreement screen, accept the terms of the agreement.

On the Installation Type screen, select the following:

m  Select from available computers on the network
The procedure does not install the client on the local machine unless
you add it to the list of systems that you want to install.

m  Either Typical or Custom installation.

m  For typical installations, NetBackup uses the default port numbers
and default service startup settings.

m  For custom installations, NetBackup lets you set service startup
settings, change port numbers, and specify the installation
location. You can also choose whether to install NetBackup
documentation, debug symbols, and VSP.

Click Next.

On the NetBackup System Names screen, provide the following information:

Master Server Name Enter the master server name here.
Additional Servers  Enter all the server names that you want the clients to access.

LiveUpdate m  Install LiveUpdate Agent

To install the LiveUpdate agent, leave the check box
checked. Otherwise, click the check box to remove the
check to prevent agent installation.

m  Location of LiveUpdate Server
Enter the network path for the NetBackup LiveUpdate
server here.

m  Server Type
Select the type of server (LAN, HTTP, or HTTPS) used for
the NetBackup LiveUpdate server.

On the Ready to Install screen, click Install.

The client software is installed on the specified machines.

If you click Cancel after you click Install, the installation does not stop
immediately. The installation continues until it is finished on the remote
system. At that point, no remote installations begin. NetBackup considers



86 | Installing clients

Installing Microsoft Windows clients

9

any remote installations that were complete when you clicked Cancel to be
successful.

On the System Validation Complete screen, click Finish.

Installing Windows clients silently

A silent installation process does not require interactive input. It does, however,
require that you edit the silentclient.cmd file before you run the script.

The following procedure performs a silent installation of NetBackup clients. One
of the clients can be the system that runs the silentclient.cmd script.

Note: Silent installations of NetBackup clients are not supported if you want to
run the NetBackup services as a user rather than as a local administrator. To
install NetBackup as a user, see “To install NetBackup client software locally on
Windows systems” on page 83. Also see “To install the Windows NetBackup
client software on remote computers” on page 84.

To perform a silent installation on Windows

1
2
3

Insert the NetBackup installation CD in the drive.
In a Microsoft Windows Explorer window, navigate to the CD drive.

Copy the contents of the PC_C1nt\ directory to a temporary folder on your
hard drive. For example, C: \ temp.

Since the files on the CD are read-only, change the permissions for these
files on the hard drive to allow the update.

In the temporary directory, use a text editor to edit the silentclient.cmd
file so the script installs the client software as needed.

Be sure to update the client, the master server, and additional servers to the
minimum required version of NetBackup.

Run the following script:
silentclient.cmd

Check the NetBackup installation log file in the following directory to verify
that the installation was successful:
C:\Documents and Settings\userid\Local Settings\temp

Configuring NetBackup clients

You can configure NetBackup clients by performing one of the following actions:
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m To add servers or media servers, start the Backup, Archive, and Restore
interface and from the File menu, select Specify NetBackup Machines.

m To display and change the client properties, start the Backup, Archive, and
Restore interface.
From the File menu, select NetBackup Client Properties.

m To display and change the server properties, start the NetBackup
Administration Console.
Expand Host Properties and click on Clients.
In the right pane, right-click on the client, and choose Properties.
All NetBackup servers that require access to your Windows client must be
listed on the Servers tab in the resulting dialog box.
For more information, refer to the NetBackup Backup, Archive, and Restore
Getting Started Guide.

Note: For NetBackup Novell NetWare Clients: The NetBackup Novell NetWare
Client Administrator’s Guide describes how to use that client to back up and
restore the data on NetWare servers.

Removing Windows clients

To remove (uninstall) the NetBackup client on Microsoft Windows clients

1  Open the Windows Control Panel (select Start > Settings > Control Panel).
2 Select Add/Remove Programs.

3  Select Veritas NetBackup Client.
4

Click Remove.

Installing UNIX clients

By definition, your NetBackup server is also a NetBackup client. When you
install the NetBackup server software, you install both the NetBackup server
and the NetBackup client software on the server.

You can install UNIX clients either locally at the client computer or remotely
from your UNIX NetBackup server. To have the ability to include a client in a
policy, the client type software must first be installed on the UNIX master
server.
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Note: Macintosh OS X10.3.x and OS X10.4.x clients are UNIX-based clients.
Follow the same UNIX client installation procedures in this section.

Use the following guidelines when you install UNIX clients:

The gzip and the gunzip commands must be installed on each system. The
directories where the commands are installed must be part of the root user’s
PATH environment variable setting.

For local installations:

You must install the client software locally if remote installation is not
possible. Remote installation is not possible if your NetBackup server
runs Windows 2000/2003 Server. Firewalls can also prevent remote
installation.

To install clients to a location other than the default, you must create
and link the directory before you install the client software. First create
the directory where you want the software to reside, and then create
/usr/openv as a link to that directory.

On IBM zSeries Linux clients, you must transfer the NetBackup CD
image contents to a location that is readable by the virtual Linux
environment. You can transfer the image with FTP or NFS mounting
commands.

For remote installations:

You can “push” the client software from your UNIX NetBackup server
to your UNIX client computers. The preferred installation method is to
push the client software.

Before you can push to a UNIX client, you must first install the
NetBackup client type software on the master server and create a
policy that includes the client name. The UNIX client must be a true
client and not a media or a master server. See “Adding a UNIX client
after initial server installation” on page 95.

Clients such as the IBM zSeries Linux may not have a locally mounted
CD device, which makes it impossible to perform a standard local
installation. To install NetBackup to clients with no local CD drive, you
must push the NetBackup installation from a UNIX master or media
server. See any of the following:

“Installing client software with the ftp method” on page 92.
“Installing client software with the rsh method” on page 90.
“Installing client software with the ssh method” on page 93
“Installing client software with the sftp method” on page 94
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To initiate a backup or a restore from a UNIX client, the following graphical
interfaces are available:

Clients that are compatible with NetBackup-Java may use the
NetBackup-Java interface (jbpsa). Refer to the NetBackup Release Notes for
a list of NetBackup-Java capable hosts.

Clients that are not compatible with NetBackup-Java can use the bp
interface. They also support a login from any NetBackup 6.5 UNIX server’s
NetBackup client console with the jbpSA command. Clients that are not
compatible with NetBackup-Java are Macintosh OS X 10.3.x and OS X10.4.x,
IBM zseries Linux, IRIX, and FreeBSD.

Installing UNIX clients locally

The following procedure installs the NetBackup client software on a local
machine.

To install client software locally on a UNIX client

1

Insert the NetBackup client CD into the drive on the client computer and
mount it.

For instructions on how to mount the CD on your operating system, refer to
the appropriate section of “Mounting the software media” on page 21. For
information on CD contents and exact names, refer to “Contents of the
NetBackup media kit” on page 10.

Change your working directory to the CD directory if you have a CD, or to the
directory that contains the downloaded files:

cd /cd_mount_point

The cd_mount_point is the path to the directory where you can access the
CD.

For Macintosh OS X 10.3.x systems only: You can access the CD from the
following location:

cd /volumes/cd name

Enter the following command to execute the installation script:
./install

The client binaries represent the operating system versions where the
binaries were compiled. Often, the binaries function perfectly on later
versions of the operating system. For example, Solaris 9 binaries also are
used on the Solaris 10 level of the operating system. The installation
procedure attempts to load the appropriate binaries for your system. If the
script does not recognize the local operating system, it presents choices.

Follow the prompts to complete the installation.
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After the installation is complete, unmount the client CD.

Installing UNIX clients remotely

You can push the client software from a UNIX master server to a client host by
using the following methods:

rsh
ftp
ssh

sftp

Note: For installation in clustered environments, enter the virtual name for the
NetBackup server and not the actual local host name. You can only push client
software from the active node.

Installing client software with the rsh method
Read the following statements before you proceed with this procedure:

To use the rsh method, the UNIX client must have an entry for the server in
its /.rhosts file. The /. rhosts entries enable software installation, but
they are not necessary for correct operation of NetBackup software.

If you want to install client software to a location other than the default, you
must first create and link the desired directory. Create the directory where
you want the client software to reside, and then create /usr/openv as a
link to that directory.

Make sure the clients are assigned to a backup policy.

For Macintosh OS X 10.3.x and OS X 10.4.x users:
By default, these operating system versions do not enable the remote shell
daemon (rshd). Run the following command to enable the daemon:

/sbin/service shell start

To install client software from a UNIX master server to UNIX clients with the
rsh method

1
2

Start the NetBackup Administration Console.

On the Login dialog box, provide the name of the NetBackup server that
contains the policy configuration with the clients.

You can install the client software only from the NetBackup server that you
specify in the Login dialog box when you start the interface. The clients
must be defined in a policy on this NetBackup server.



6

Installing clients
Installing UNIX clients

In the NetBackup Administration Console window, click on the NetBackup
Management icon to show the available options.

In the left pane, click Policies.

In the All Policies pane, select the master server.
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In the Don’t install these clients list, select the clients you want to install
and click Add >>.
The clients are moved to the Install these clients list.

To start the installation, click Install Client Software.

Client software installation can take a minute or more per client. NetBackup

writes messages in the Progress box as the installation proceeds.

If the installation fails on a client, NetBackup notifies you but keeps the

client in the policy.

You cannot stop the installation after it has started.

During installation, NetBackup does the following:

m  Copies client software from /usr/openv/netbackup/client on the
server to /usr/openv/netbackup on the client.

m  Adds the appropriate entries to the client’s /etc/services and
inetd.conf files or xinetd.d directory.

After the installation is complete, click Close.

Installing client software with the £tp method
Read the following statements before you proceed with this procedure:

If you want to install client software to a location other than the default, you
must first create and link the desired directory. Create the directory where
you want the software to reside, and then create /usr/openv as a link to
that directory.

Make sure the clients are assigned to a backup policy.

For Macintosh OS X 10.3.x and OS X 10.4.x users:

m By default, these operating system versions do not enable the FTP
daemon (£tpd), which is required. In the sharing pane of the System
Preferences application, check Allow FTP access to enable ftpd.

m If you have a firewall that is enabled, you must enable FTP access.

In the System Preferences sharing pane under Firewall, check FTP
Access to allow FTP connections.

To install client software from a UNIX master server to UNIX clients with the
ftp method

1

Run the install_client_files script on the NetBackup server to move

the client software from the server to the /tmp directory on the client.

You must have a login ID and password that you can use to access the

clients through FTP.

m  To move software to only one client at a time, run the following
command:
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/usr/openv/netbackup/bin/install_client_files ftp client user
The client is the host name of the client.

The useris the login id that FTP requires on the client.

m  To move software to all clients at once, run the following command:
/usr/openv/netbackup/bin/install_client_files ftp ALL user
The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.
The useris the login id required by FTP on the client.

The install_client_files script prompts you for a password for
each client if you do not have a .netrc file set up.

2 Aftertheinstall_client_files script runs, the root user on each client
machine must run the following client_config script:
sh /tmp/bp.pid/client_config
The pidis the process ID. The client_config script installs the binaries
and updates the /etc/services and inetd. conf files or the xinetd.d
directory, as appropriate.

Installing client software with the ssh method
Read the following statements before you proceed with this procedure:

m To use the ssh method, the UNIX client must have the SSH daemon (sshd)
enabled and configured to allow root user logins.

m If you want to install client software to a location other than the default, you
must first create and link the desired directory. Create the directory where
you want the client software to reside, and then create /usr/openv as a
link to that directory.

m  Make sure the clients are assigned to a backup policy.

m  For Macintosh OS X 10.3.x and OS X 10.4.x users:

m By default, these operating system versions do not enable the SSH
daemon (sshd). You must first enable this daemon in order to perform
the following procedure successfully.

In the System Preferences sharing pane, check Remote Login to enable
sshd.

m If you have a firewall that is enabled, you must enable ssh connections.
In the System Preferences sharing pane under Firewall, check Remote
Login - SSH to allow SSH connections.

To install client software from a UNIX master server to UNIX clients with the
ssh method

m Runtheinstall_client_files script on the NetBackup server.
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m  To move software to only one client at a time, run the following
command:

/usr/openv/netbackup/bin/install_client_files ssh client
The client is the host name of the client.

m  To move software to all clients at once, run the following command:
/usr/openv/netbackup/bin/install_client_files ssh ALL
The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.

Installing client software with the sftp method

Read the following statements before you proceed with this procedure:

To use the sftp method, the UNIX client must have the SSH daemon (sshd)
enabled and configured to allow root or non-root user logins.

If you want to install client software to a location other than the default, you
must first create and link the desired directory. Create the directory where
you want the software to reside, and then create /usr/openv as a link to
that directory.

Make sure the clients are assigned to a backup policy.

For Macintosh OS X 10.3.x and OS X 10.4.x users:

m By default, these operating system versions do not enable the ssh
daemon (sshd). You must first enable this daemon in order to perform
the following procedure successfully.

In the System Preferences sharing pane, check Remote Login to enable
sshd.

m If you have a firewall that is enabled, you must enable SSH connections.
In the System Preferences sharing pane under Firewall, check Remote
Login - SSH to allow SSH connections.

To install client software from a UNIX master server to UNIX clients with the
sftp method

1

Run the install_client_files script on the NetBackup server to move

the client software from the server to the /tmp directory on the client.

m  To move software to only one client at a time, run the following
command:

/usr/openv/netbackup/bin/install_client_files sftp client user
The client is the host name of the client.

The useris the login id that SSH requires on the client.

m  To move software to all clients at once, run the following command:
/usr/openv/netbackup/bin/install_client_files sftp ALL user
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The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.

2 Afterthe install_client_files script runs, the root user on each client
machine must run the client_config script:
sh /tmp/bp.pid/client_config
The pidis the process ID. The client_config script installs the binaries
and updates the /etc/services and inetd. conf files or the xinetd.d
directory, as appropriate.

Adding a UNIX client after initial server installation

You may want to add UNIX clients after the server installation if you forgot to
select one during the installation. You may also add a new UNIX client type to
your backup environment.

To install client software later, you must first install the NetBackup client
software onto the NetBackup server.

The client CD’s installation script lets you install the client software on the
server for each of the UNIX client types that NetBackup supports. You can then
“push” this client software from the server to your UNIX clients.

To add UNIX client types to servers after initial installation

1  Mount the client CD to open a menu that displays the available client types.
For instructions on how to mount the CD on your operating system, refer to
the appropriate section of “Mounting the software media” on page 21. For
information on CD contents and exact names, refer to “Contents of the
NetBackup media kit” on page 10.

2 Change your working directory to the CD directory if you have a CD or to the
directory that contains the downloaded files:
cd /cd_mount_point

The cd_mount_point is the path to the directory where you can access the
CD.

3 Enter the following command to execute the installation script:
./install
The client binaries represent the operating system versions on which the
binaries were compiled. Often the binaries function perfectly on later
versions of the operating system. For example, Solaris 9 binaries also are
used on the Solaris 10 level of the operating system. The installation
procedure attempts to load the appropriate binaries for your system. If the
script does not recognize the local operating system, it presents choices.
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Select the client type that you want to load and follow the prompts to install
that client type. Repeat as necessary until all the client types you want are
loaded.

Make sure you load the software for all the UNIX client types you intend to
back up onto the server. Otherwise, you cannot add these client types to the
NetBackup policy configuration.

After the installation is complete, unmount the client CD.

Install the NetBackup client software on the clients you specified, as
described in “Installing UNIX clients remotely” on page 90.

Removing UNIX NetBackup client software

If you remove NetBackup from a machine with the NetBackup-Java Display
Console installed, the console is also removed.

To remove UNIX NetBackup client software

1
2

Log in to the client system as the root user.

Navigate to the /usr/openv directory.

m If /usr/openv is a physical directory, run the following command:
rm -rf /usr/openv
m If /usr/openv is alink, run the following commands:

cd /usr/openv
pwd
1s

Caution: Make sure you are at the proper location and verify that the
subdirectories are what you would expect them to be before continuing. You
do not want to remove the wrong directories. For this reason, the first
commands verify your current location and the files in that directory,
before removing files.

rm -rf *
cd /
rm -f /usr/openv

Warning: The rm -f /usr/openv command also removes any add-on
products that are installed on this machine.

Remove NetBackup entries in the client’s /etc/services file. Locate the
lines, marked by the following strings and delete them:

# NetBackup services#

# End NetBackup services #
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# Media Manager services #

# End Media Manager services #

If you do not see these strings, it may be because you upgraded from an
earlier release of NetBackup. You can also remove bpcd, bpjava-msvc,
bprd, vnetd, and vopied without searching for the #End. . . # strings.
You are not required to remove the strings from /etc/services. Any
operations that access the file can function with or without the services
being listed.

Note: For Macintosh OS X 10.3.x systems: The NetBackup installation
updates the /etc/services file with these entries. However, earlier
NetBackup releases may have updated the /services directory of the
NetInfo database. To remove NetBackup and its services, use the
NetManager utility to delete the following files from the /services
directory: bpcd, bpjava-msvce, bprd, vnetd, and vopied.

Remove the NetBackup entries in the /etc/inetd. conf file by deleting
the lines for bpcd, vnetd, vopied, and bpjava-msvc.

Ensure that the inetd daemon reads the updated inetd.conf (or
inetd.local) file.

m  Determine the process ID of inetd. The ps command options vary
from one UNIX operating system to another. Following are two
examples.

For most UNIX clients, run the following command:

ps -ea | grep inetd

For MacOS X 10.3.x and FreeBSD, run the following command:
ps -ax | grep inetd

The process ID is the first number displayed in the ps command
output.

m  HUP the inetd daemon, as follows.
kill -1 process ID
The ki1l command option may vary from one client platform to
another.

For the NetBackup-Java capable clients that run the NetBackup
Administration Console for UNIX, remove the NetBackup-Java state data, as
follows:

/bin/rm -rf /.nbjava
/bin/rm -rf /.java/.userPrefs/vrts
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Warning: There should be no space between the slash “/” and the period “.”
of “/ .nbjava”. If you add a space between these characters, all files on this
machine are removed.

Inform users of NetBackup-Java that they can remove the $SHOME/ .nbjava
and portions of the SHOME/ . java directories.

The $HOME/ .nbjava and SHOME/ . java directories contain application
state information (such as table column order and size). This information is
saved when the user exits NetBackup-Java applications. When you remove
NetBackup, the process removes this directory for the root user only.

The common subdirectory in $HOME/ . java/.userPrefs/vrts can be
removed.

If you enabled NetBackup access control, NetBackup created new files on
clients and servers that can be divided into two categories:
m Individual user files
Individual user cache files exist in their home directories (for example,
in SHOME/ . vxss). Inform those users that they can remove the
$HOME/ .vxss directory.
m  NetBackup application temporary files
NetBackup temporary files are removed with NetBackup.
For more information on NetBackup access control, please see the
NetBackup Administrator’s Guide, Volume II.
For more information on Veritas Security Services and how to remove the
software, see the NetBackup Security and Encryption Guide.
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This chapter includes the following topics:
m  “Configuring NetBackup Startup and Shutdown”
m  “Configuring Storage Devices for the Operating System”

m  “Configuring NetBackup Server Software”

Configuring NetBackup Startup and Shutdown

Startup scripts allow the Media Manager and NetBackup daemons to start
automatically when the system boots. Shutdown scripts automatically
terminate the startup scripts at system shutdown.

Note: For non-cluster upgrades: Any pre-existing NetBackup related startup and
shutdown scripts are saved, and the newly released versions of that script are
installed.

The installation process copies the appropriate startup or shutdown script from
the /usr/openv/netbackup/bin/goodies directory to the init.d
directory. A new link is then created to it from the appropriate rc directory.

Note: For clustered environments: All of the startup and the shutdown scripts are
removed from the rc directories. Clustered NetBackup environments do not use
these scripts.
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The installation process installs the links to the startup and the shutdown
scripts on the various platforms as shown in the following table.

Platform Links

AIX

/etc/rc.netbackup.aix
m  Youmust edit /etc/inittab and add the following entry to ensure that the script
is called during a level-two boot: netbackup:2:wait:/etc/rc.netbackup.aix
To shut down, add the following line to /etc/rc.shutdown

/etc/rc.netbackup.aix stop

ALPHA Tru64 /sbin/rc3.

/sbin/rc0

d/S77netbackup ->/sbin/init.d/netbackup
.d/KOlnetbackup ->/sbin/init.d/netbackup

HP-UX /sbin/rc2
/sbin/rcl
/sbin/rcl

/sbin/rc2

.d/S777Tnetbackup ->/sbin/init.d/netbackup
.d/K001lnetbackup ->/sbin/init.d/netbackup
.d/K00lnbclient ->/sbin/init.d/nbclient
.d/s951nbclient ->/sbin/init.d/nbclient

Linux Red Hat d/rc2
d/rc3
d/rc5
d/rcé6
d/rcl
d/rc0
d/rc0
d/rcl
d/rc2
d/rc3
d/rc5
d/rcé6

.d/S77netbackup
.d/S77netbackup
.d/S77netbackup
.d/KO0lnetbackup
.d/KO0lnetbackup
.d/KO0lnetbackup
.d/KO0lnbclient
.d/KO0lnbclient
.d/S95nbclient
.d/S95nbclient
.d/S95nbclient
.d/KOlnbclient

d/init.
d/init.
d/init.
d/init.
d/init.

->/etc/rc.d/init.
->/etc/rc.d/init.
->/etc/rc.d/init.
->/etc/rc.d/init.
d/init.
d/init.
d/init.

d/netbackup
d/netbackup
d/netbackup
d/netbackup
d/netbackup
d/netbackup
d/nbclient
d/nbclient
d/nbclient
d/nbclient
d/nbclient
d/nbclient

->/etc/rc.
->/etc/rc.
->/etc/rc.

/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc. ->/etc/rc.
/etc/rc. ->/etc/rc.
/etc/xc.
/etc/rc.
/etc/rc.
/etc/rc.
/etc/rc. ->/etc/rc.
/etc/rc. ->/etc/rc.

/etc/rc. ->/etc/rc.

Linux SuSe

/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.
/etc/init.

d/rc2
d/rc3
d/rc5
d/rcé6
d/rc0
d/rc0
d/rc2
d/rc3
d/rc5
d/rcé6

.d/S77netbackup
.d/S77netbackup
.d/S77netbackup
.d/K0lnetbackup
.d/KO0lnetbackup
.d/KOlnbclient
.d/S95nbclient
.d/S95nbclient
.d/S95nbclient
.d/KOlnbclient

->/etc/init.
->/etc/init.
->/etc/init.
->/etc/init.
->/etc/init.

->/etc/init.
->/etc/init.
->/etc/init.
->/etc/init.
->/etc/init.

d/netbackup
d/netbackup
d/netbackup
d/netbackup
d/netbackup
d/nbclient
d/nbclient
d/nbclient
d/nbclient
d/nbclient
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Platform Links

Default (all other /etc/rc2.d/S77netbackup ->/etc/init.d/netbackup

UNIX systems) /etc/rcl.d/KOlnetbackup ->/etc/init.d/netbackup
/etc/rc0.d/KO0lnetbackup ->/etc/init.d/netbackup
/etc/rc2.d/S95nbclient ->/etc/init.d/nbclient
/etc/rcl.d/KO0lnbclient ->/etc/init.d/nbclient
/etc/rc0.d/KO0lnbclient ->/etc/init.d/nbclient

Configuring Storage Devices for the Operating

System

Reliable use of NetBackup depends on the configuration of your storage devices.
Before you configure your NetBackup environment, you must first complete the
configuration of all storage devices. Follow the instructions as provided by the
device and operating system vendors.

Caution: An improperly configured device may lead to backup failures, data loss,
or both.

For clustered environments:

m  Begin configuring all storage devices from the active node. Refer to
“Configuring NetBackup Server Software” on page 102 for guidelines on
how to configure storage devices to work with NetBackup.

m  For a NetBackup failover server, attach all of the devices to each node in the
cluster on which NetBackup is installed. Refer to the clustering vendor’s
documentation for information on how to migrate to another node.

Note: To connect a device to the operating system, refer to the Veritas
NetBackup Device Configuration Guide on the NetBackup Documentation CD.
See the chapter appropriate for your operating system.

To prepare a newly connected storage device

1  Consult your storage device's operating manual or front panel to learn how
to set the SCSI ID (target). Ensure it is set it to an available SCSI ID.

2 Physically attach your device to a compatible host bus adapter where that
SCSIID is available. “Compatible” means that both the device and the host
bus adapter are of the same type. For example, single-ended, high voltage
differential, low voltage differential, or fibre channel.
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3 For clustered environments:
Robotic devices and NetBackup add-on products can be configured to
failover NetBackup if the robot or add-on product fails. Before you
configure this failover, you must configure the robots as described in this
section.
Refer to the Veritas NetBackup High Availability Administrator’s Guide for
instructions on how to configure devices or add-on products to fail over
NetBackup.

Note: Robots must be configured before you perform the following steps.

m Configure NetBackup to fail over if a robotic daemon fails.
m  Configure your robots on each node in the cluster.

m  Run the following script:
/usr/openv/netbackup/bin/cluster/cluster_config -r

m  Add the daemon by choosing a (Add).

m  Specify the name of the robotic daemon you want to monitor.
(Multiple robots can be added.)

m Toremove a robotic daemon from monitoring, do the following:

m  Run the following script:
/usr/openv/netbackup/bin/cluster/cluster_config -r

m  Remove the daemon by choosing d (Delete).

m  Specify the robot daemon type that you would like to remove.

Configuring NetBackup Server Software

After the server software and storage devices have been installed, use the
Getting Started wizard on the NetBackup Administration Console to configure
your product.

For more information on how to configure NetBackup, refer to the Veritas
NetBackup Administrator’s Guide for UNIX and Linux, Volume L

Note: Before you configure NetBackup, you must have the storage devices
attached to the server. You must also perform all configuration steps specified
by the device and the operating system vendor. You must also install any
required device drivers.

Note: For clustered environments: Configure devices on every node in the cluster.
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The Veritas NetBackup Administrator’s Guide for UNIX and Linux, Volume I
describes the group of NetBackup configuration wizards.

This section steps you through the procedures that allow you to configure a test
system.

Note: For initial NetBackup configuration, Symantec recommends that you click
the Getting Started icon and use the wizards to guide you through the process. If
you have already configured NetBackup, and you want to make a change to
particular area, you can click any of the remaining options.

Before Configuring Media Servers

Use the following guidelines when configuring NetBackup media servers:

m  NetBackup Enterprise servers
The procedures for configuring master and media servers are very similar.
However, Symantec recommends that you install all master server and
media server software before you configure any servers. Then configure all
server information such as storage devices and volumes from the master
server. Following this order helps ensure that the master servers properly
administer the media servers.

m Clustered environments
Unless otherwise noted, configure NetBackup to use the virtual host names
of master servers and media servers in the cluster. Refer to the Veritas
NetBackup High Availability Administrator’s Guide for information on how
to configure an add-on product to fail over.

Warning: Communication problems between the master server and the
media server do not prevent you from running the configuration wizards.
Therefore, do not run the wizards on the media server until the problems
are corrected. If you run any of the wizards when a communication problem
exists, the master server cannot recognize the information that you enter.
You must first correct the problem. After you correct the problem, you
should run the configuration wizards from the master server.

Starting the NetBackup Administration Console

You use the NetBackup Administration Console to configure NetBackup.

To start the NetBackup Administration Console on UNIX

1 Login to the NetBackup server machine as root.
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For clustered environments: Log on to the active node as root.

If you need to run the user interface on a computer other than the
NetBackup server, log on to that computer.

On UNIX systems, log on as root.

For Windows systems log on as the Administrator.

2  On UNIX systems, run the following command:
/usr/openv/netbackup/bin/jnbSA &
The login box appears.

3  Enter the password for root.
For clustered environments: When you log in to the NetBackup
Administration Console, specify the virtual host name in the Host text box.

4  Click Login.

5 To begin configuring your product, on the Administrator’s Console, click
Getting Started. The Welcome to NetBackup screen appears as the
beginning of the configuration wizards.

Click Next.
The Device Configuration screen appears and prompts you to begin the
Device Configuration wizard.

Note: Two wizards are available from the initial NetBackup Administration
Console window that are not part of the Getting Started wizard. They can help
create a snapshot backup and recover the NetBackup catalog should you need to
do so for disaster recovery. See the NetBackup Administrator’s Guide for UNIX
and Linux, Volume I for information about those wizards.

Configuring Storage Devices

Before you can run backups, you must define your storage devices for
NetBackup. The Device Configuration wizard steps you through this process.
However, you must be certain that you have correctly configured your storage
devices for your UNIX system. NetBackup cannot function reliably unless
devices are correctly installed and configured.

Note: For clustered environments: Begin configuring all storage devices from the
active node. You must refer to the Veritas NetBackup High Availability
Administrator’s Guide for instructions. For a NetBackup failover server,
Symantec recommends that you attach all of the devices to every node on which
NetBackup is installed.
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The Device Configuration wizard takes you through the following processes:

Scanning hosts for backup devices
Verifying the devices that were automatically detected
Verifying and correcting the drive configuration

Updating the device configuration

Device Configuration Tips

You must specify the hosts on which to auto-discover and configure devices.

From the Backup Devices screen, confirm that the displayed list of devices is
complete and accurate. If a known backup device does not appear in this list,
you can do the following:

m  Verify that the backup device is physically attached to the host.

m  Verify that all installation procedures that specified by the device and
the operating system vendor have been performed successfully.

Verify that all drives correspond to the proper device. If you need to move a
drive, select the drive and drag it to the correct location.

Device configuration updates can take a few minutes to complete.

Defining Storage Units

You define storage units from the Configure Storage Units screen. If your
system does not have a tape device, you can store data on a disk by defining
disk storage units.

When you enter a path for a storage unit, the following rules apply:

m  Use the correct path separators (forward slash (/) for UNIX and
backward slash (\) for Windows).

m  Use a colon (:) to specify a drive separation on Windows platforms.
m  Use the following characters only:

m  Alphabetic characters (ASCII A-Z, a-z)

m  Numeric characters (0-9)

m  Miscellaneous characters: plus (+), minus (-), underscore (_), or
period (.)

Configuring Volumes

After you have configured your storage devices, the Getting Started wizard
begins the Volume Configuration wizard.
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Note: For clustered environments: Configure volumes from the active node.

Note: If you only have disk storage capability, NetBackup skips this wizard.

The Volume Configuration wizard lets you do the following:
m  Select a device for volume configuration

m  Perform an inventory of the robot

m Create new volumes

m  Create new volume groups

Tips for the Inventory of a Standalone Drive

m  The Volume Configuration wizard does not enable you to configure cleaning
tapes for stand-alone drives.

®  You can select the number of volumes for your device.

Tips for the Inventory of a Robot

m  NetBackup conducts an inventory of the robot or device that you selected.
Check the Results: field after the inventory completes to view what the
inventory discovered.

m  After the inventory process of your device completes, the wizard prompts
you to identify which slots in it contain cleaning media.
If you upgraded NetBackup and have pre-existing barcode rules, the
barcode reader automatically detects slots designated for cleaning media. If
you do not designate cleaning slots, NetBackup considers all media
(including cleaning media) as typical media and tries to overwrite it.

m Ifyouidentified one or more tapes as cleaning tapes in the Identify Cleaning
Media screen, you see the Robot Inventory (Cleaning Media) screen. It
displays the results after the software updates the EMM database.

Configuring the Catalog Backup

The NetBackup Catalog contains information about your configuration and
about the files and directories that have been backed up. If a disk fails and your
catalog is lost, a catalog backup makes it easy to restore your data and resume
your backup schedule.

Make sure that you configure a catalog backup before backing up any other data.
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Note: For clustered environments: Instructions on how to configure a catalog
backup are provided in the NetBackup High Availability System Administrator’s
Guide.

The Catalog Backup wizard lets you do the following:

Create a policy for catalog backup, if one does not exist.

Specify destinations for the catalog backup. A backup destination can be
either removable media or a location on a hard drive.

Specify when a backup of the NetBackup Catalog occurs.

For NetBackup Enterprise Server environments: You can specify a media
server to perform the backup.

Basic Tips for Configuring a Catalog Backup

Use the following information to configure a catalog backup.

Symantec recommends that you back up the catalog to tape, if possible.

The Catalog Backup wizard allows you to configure either an online, hot
catalog backup or an offline, cold catalog backup.

The online, hot catalog backup was introduced with NetBackup 6.0. The
online, hot catalog backup is designed for use in very active NetBackup
environments with large catalogs. Online, hot catalog backups can back up
the catalog while continual client backups are in progress.

The offline, cold catalog backup works well for less active environments
with smaller catalogs. This type of backup cannot span tapes. It also
requires that NetBackup be quiesced before backups can be run: it cannot
back up the catalog while any job or any catalog operation is running.
For details on the best catalog for your environment, see the Veritas
NetBackup Administrator’s Guide for UNIX and Linux, Volume I. Refer to
the chapter on NetBackup catalogs.

Tips for Configuring a Catalog Backup if You Have Media
Servers

For systems with media servers, the master servers or the media servers can
perform backups. Use the following information to configure a catalog backup.

First, select a media server.

To back up the catalog to removable media, select the media server with the
drive(s) where you want the backup to reside.

To back up the catalog to a hard drive (which is not the recommended
method), specify the computer that contains the hard drive.
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From the NetBackup Catalog Files screen, you verify that the master server's
and each media server's catalogs are included in the list.

Verify that the absolute path names are correct and are in the correct
format. Follow the instructions on the screen for specifying the entire list.
The catalog path names on the master server are added automatically
during installation. Generally, no action on your part is required other than
to verify that path names are listed. However, if you have moved the
location of your catalog on your master server, the new location must be
specified. Path names to the NetBackup catalog on the media servers are
not automatically added during installation. You must add them to the file
list. For more information on how to specify the path names, see Veritas
NetBackup Administrator’s Guide for UNIX and Linux, Volume L.

Creating a Backup Policy

The Backup Policy wizard lets you define a backup policy for a group of one or
more clients. The wizard lets you specify the following:

Policy names and types

Clients

Files and directories to back up
Backup types

Backup rotations

Starting times of backups

Note: For clustered environments: Configure the policy from the active node.

Types of Backups

The Backup Policy wizard prompts you to choose the type of backup that you
want a policy to perform. The following list summarizes your choices:

A Full Backup backs up all files that are specified in the file list.

An Incremental Backup backs up all the changed files that are specified in
the file list.

m A Differential Backup is often called a differential incremental backup.
It backs up the files that have changed since the last successful
incremental or full backup. All files are backed up if no previous backup
has been done.



Initial Configuration
Configuring NetBackup Server Software

m A Cumulative Backup is often called a cumulative incremental backup.
Only the files that changed since the last successful full backup are
backed up. All files are backed up if no previous backup has been done.

A User Backup is initiated by an end-user to back up specific files.

Tips on Creating Backup Policies

The list that appears on the Client List screen of the Backup Policy wizard is
a list of clients that are backed up. You can add, change, or delete clients
from this list by selecting a name. Then click on the appropriate button.

You can select how often you want a backup policy to run for full or
incremental backups. In addition, you can select the retention period for the
backups.

After you have completed the Backup Policy wizard, you are asked if you want to
perform an installation verification test. To do this test click the Activity
Monitor in the left pane of the NetBackup Administration Console. You can now
monitor the progress of the backup job.
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NetBackup LiveUpdate

This appendix includes the following topics:

m  “About NetBackup LiveUpdate”

“Setting up your NetBackup LiveUpdate server”
“Changing the NetBackup LiveUpdate configuration”
“About LiveUpdate policies”

“Uninstalling NetBackup LiveUpdate”

About NetBackup LiveUpdate

NetBackup 6.5 includes a new NetBackup LiveUpdate feature. NetBackup
LiveUpdate provides a cross-platform, policy-driven method to distribute
NetBackup Release Updates to NetBackup 6.5 clients.

Note: This document describes LiveUpdate as it pertains to NetBackup.
NetBackup LiveUpdate should not be confused with Symantec LiveUpdate. If
you would like more information about Symantec LiveUpdate, go to the
following Website: http://www.symantec.com

The NetBackup LiveUpdate feature includes the following versions of Symantec
LiveUpdate agents:

m  For Windows:
Windows LiveUpdate Agent version 3.2

m  For UNIX:
Java LiveUpdate Agent version 3.5

With the agent installed, you can download updates from a designated
NetBackup LiveUpdate server where the NetBackup updates reside.


http://www.symantec.com
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You can download and install NetBackup Release Updates, NetBackup add-on
products, and PBX. Only NetBackup versions 6.5 and later can be used with
NetBackup LiveUpdate.

NetBackup LiveUpdate features include the following:

m  Downloaded updates can be installed remotely to NetBackup servers and
clients.

m  Cross-platform installation of updates is supported for both Windows and
UNIX.

m  Updates can be downloaded and installed on Windows and UNIX clustered
systems.

m  Using LiveUpdate for update installation does not require local
administrator privileges on NetBackup installations, except on Windows
clustered systems. However, you must have privileges to run NetBackup
policies from the NetBackup master server.

NetBackup LiveUpdate is an additional method to obtain updates quickly and
more conveniently. The current program for customers to obtain updates
remains in place.

Note: NetBackup LiveUpdate only allows release update downloads. Major and
minor NetBackup releases cannot be downloaded.

How NetBackup LiveUpdate works

The LiveUpdate process is managed manually to help you control which
machines are updated and when the updates occur.

The following describes how updates are downloaded and installed:

m  First, manually download NetBackup Release Update packages from a
Symantec support site to your designated NetBackup LiveUpdate server.
Update packages include two zipped files; one for Windows and one for
UNIX.

m  Secondly, create and run a LiveUpdate policy on your NetBackup master
server. The policy starts a LiveUpdate session with the clients in the policy.
If you have media servers, the LiveUpdate process uses them to pass
information between the master server and the clients.

m  Finally, the LiveUpdate agent on each client checks with the LiveUpdate
server for any available updates. The agent then launches the NetBackup
update installation scripts and installs the updates silently.
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Setting up your NetBackup LiveUpdate server

Use the following guidelines to set up your NetBackup LiveUpdate server:

Setting up your NetBackup LiveUpdate server does not require installation
of any special software.

A NetBackup LiveUpdate server can be any Windows or UNIX host. It is not
necessary to have NetBackup software installed on your NetBackup
LiveUpdate server.

If you have a local LiveUpdate server that is dedicated for other Symantec
products like Norton Anti-Virus, avoid conflicts by using one of the
following guidelines:

m  Download the NetBackup Release Updates to a different directory on
your local Symantec LiveUpdate server.

m  Designate a different machine as your NetBackup LiveUpdate server.
Your NetBackup LiveUpdate server requires any one of the following:

m A shared disk or partition that can be accessed by any NetBackup
LiveUpdate host (server or client)

m  HTTP or HTTPS server configuration

Note: HTTPS servers must use the certificate signed by a certificate
authority.

Installing on Windows systems

You can install and configure NetBackup LiveUpdate agent on Windows systems
with one of the following methods:

Use the NetBackup installation wizard

When you install or upgrade NetBackup 6.5 server or client software, the
LiveUpdate agent software is installed by default. On the NetBackup System
Names window in the installation wizard, a LiveUpdate section lets you set
up the installation.

Modify the LU_TInstall.bat file and run it

Note: At a minimum, you must have the NetBackup client installed to use
NetBackup LiveUpdate.
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To install and configure NetBackup LiveUpdate with the NetBackup
installation wizard

1

Start the NetBackup installation wizard.

Refer to Chapter 2,

“Installing or upgrading NetBackup server software” or

Chapter 5, “Installing clients”.

Select the installation type, either local or remote.

Follow the installation wizard instructions.

On the NetBackup System Names screen, provide the following information:

H i3 veritas NetBackup = =l [ |
MetBackup System Names
Enter the names of the susters that wil be allowed to access this system. , Smmtec‘
S
\IWE\CDmI
vlicense
P Master Server Name: zephir
+Licenzing Additional Servers =
Systerm Names
EMM Server
Install =l

Technical Support

Livelpdal
¥ Install LiveUpdate &gent

Location of Livelpdate Server

|\\cnmpulemame lu comiLivellpdate

Sever Type & LAN COHTTP € HTTPS

Back Next Cancel

Master Server Name

Additional Servers

Install LiveUpdate
Agent

Enter the name of the master server.

Enter the names of any additional machines (servers) that are
allowed to access this server. If you enter more than one
name, separate each name with a comma.

If you plan to install the EMM server on a media server
instead of the master server, you must include that server
name here.

The LiveUpdate agent allows installation of NetBackup
release updates from a LiveUpdate server.

Even if you choose not to use LiveUpdate, agent installation
does not affect NetBackup installation, configuration, or
operation.
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Location of The LiveUpdate server is the machine where you store
LiveUpdate Server  NetBackup release updates. The default server location is
your NetBackup master server.

If you want to designate a different machine as your
NetBackup LiveUpdate server, type the appropriate pathname
for that server here.

Server Type Select the protocol that is used by your LiveUpdate server
(LAN, HTTP, or HTTPS).

For NetBackup When you install media server software, this screen has an

Enterprise media additional line with the media server name shown as the local

server installations  server. You must change the name to the master server name

only to which the media server is configured.

For cluster systems, the NetBackup Client service must be set up to run as an
administrator and not as a regular user. Change the privileges to
administrator on the NetBackup Services screen. Provide the following
startup account and startup type information for NetBackup services:

i Veritas NetBackup

NetBackup Services

’ symantec.

Chanse the usemame and password and the startup ype to be used for the Yerias
viielcome MetBackup services.

v License

¥ Install Choice

v Licensing Usemame | 7 Teminate MetBackup processes
Options Password | [™ Teminate Windows processes
System MNames  Domain | ﬂ ™ Abort instal if reboot is required
EMM Serer Startup:

& Automatic " Manual

Install

|¥ Start NetBackup Server Services After Install

echnical Support

Back Cancel
Use the built-in Clear this box and fill in the three fields below it.
system account
User name, Enter the necessary information that allows administrator

Password, Domain  privileges. Be sure to leave the Use the built-in system
account check box unchecked.

Startup Select either Automatic or Manual start up.
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Start NetBackup Check this box if you want to start the services after

Server Services After installation. You can leave the box unchecked to prevent
Install services from starting after installation.

Terminate Check this box to prevent a reboot while you perform a remote
NetBackup installation. When you check this box, processes that use the
processes NetBackup executables and DLLs are stopped.

Caution: For Oracle users: If you select Terminate NetBackup
processes, you must take down your database before you
continue the installation.

Terminate Windows Check this box to prevent a reboot while you perform a remote
processes installation. When you check this box, processes that use the
Microsoft run-time DLLs are stopped.

For upgrades: You do not need this option because the
Microsoft run-time DLL is already at the correct level.

Caution: If you select Terminate Windows processes, it may
cause instability with other Windows applications,
particularly those applications that use run-time DLLs.

Abort install if a Check this box so that NetBackup can detect if the remote
reboot is required system requires a restart.

If a restart is required, this option ends the installation and
rolls the remote system back to its state at the beginning of
the installation.

Click next on the wizard screens that follow until you get to the Ready to
Install Program screen, then click on Install.

On the Installation Complete screen, click Finish.

To install and configure NetBackup LiveUpdate by modifying the
LU_Install.bat file

1

Open the LU_Install.bat file in a text editor. The file is located on your
NetBackup CD-ROM in the Addons\LiveUpdate directory.

At the SET LU_SERVER-= line, edit the line by entering the name of your
LiveUpdate server.

Make sure that the LuCheck.exe, LU_Registration.exe, and
LUSetup.exe files are in the same directory.

Save the changes and close the file.

Run the LU_Install.bat file.
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Installing on UNIX systems

The NetBackup LiveUpdate agent software is located on the NetBackup Options
CD and must be installed separately.

The following describes the UNIX installation guidelines:

m  Server installation requires that you load Java LiveUpdate software from the
NetBackup Options CD first, then run an installation script.

m Client installation can be done individually on each NetBackup client, or the
server can push the LiveUpdate agent software to all clients at once.

m  NetBackup does not deliver Java JRE for the following UNIX platforms:
FreeBSD, IBMpSeries, IBMzSeries, MacIntosh, and SGI.
Before you install and use NetBackup LiveUpdate on these platforms, you
must do the following:

m A minimum Java Runtime of 1.4.2 must be used to install Java
LiveUpdate. The JRE used should be enabled with JCE Unlimited
strength jurisdiction policy files. You can download the necessary files
from the Sun Microsystems Website.

m Have the appropriate version of Java JRE installed.

m  Create the following directory:

mkdir -p /usr/openv/java/jre/bin

m  Run the following command to create a link to the directory you just
created:

In -s <system java path> /usr/openv/java/jre/bin/java

Installing the agent on UNIX servers

Use these steps to load and install LiveUpdate agent software on a UNIX server.
To load and install the NetBackup LiveUpdate agent software on a UNIX

server

1 Login to the server as root.

2 Insert the NetBackup Options CD and mount it.

3 Run the following script, which launches the NetBackup add-on product
software installation script:

cd_directory/install
The cd_directoryis the path to the directory where you can access the
CD.

4 Atthe Installation Options prompt, select NetBackup Add-On
Product Software.
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0 N o O

10

11

Select NetBackup LiveUpdate Agent.
Select Done Selecting Products.
Atthe Is this list correct? prompt, selecty.

To load NetBackup LiveUpdate agents for platform other than the server
platform, press enter to accept the default (y) or select n.

If you selected (y) to load other platforms on the server, enter the
LiveUpdate agent client platforms.

Select g to quit from the script.

Run the following script, which installs and configures the NetBackup
LiveUpdate agent on the server:

/usr/openv/netbackup/bin/install_nblu

When you are asked for the protocol and location to use for the NetBackup
LiveUpdate server, enter the appropriate protocol and pathname.

Note: Remember, the NetBackup LiveUpdate server is where the NetBackup
release updates reside. You must download the updates to this server
manually from a support Web site. When you run the NetBackup
LiveUpdate policy, the NetBackup clients in the policy access this server for
the update files.

Installing the agent on UNIX clients

Use one of the following procedures to install NetBackup LiveUpdate agent
software on a UNIX client. Choose either local UNIX client installation or push
to all clients from the server.

To install LiveUpdate agent software locally on a UNIX client

1
2
3

Log in to the client as root.
Insert the NetBackup Options CD and mount it.

Run the following script, which launches the NetBackup add-on product
software installation script that installs the agent:

cd_directory/install
The cd_directoryis the path to the directory where you can access the
add-on products.

When you are asked for the protocol and location to use for the NetBackup
LiveUpdate server, enter the appropriate protocol and pathname.
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Note: Remember, the NetBackup LiveUpdate server is where the NetBackup
release updates reside. You must download the updates to this server
manually from a support Web site. When you run the NetBackup
LiveUpdate policy, the NetBackup clients in the policy access this server for
the update files.

To install the LiveUpdate agent software remotely on all clients

1

Log in to the server as root.

You must log in to the server where you loaded the LiveUpdate agent
software for the selected platforms.

Use the bpplclients command to create a file that contains a list of
clients currently configured in the NetBackup database.

Choose the correct command based on whether you push from a master
server or from a media server, as follows:

m  To push from the master server, run the following command:

./bpplclients -allunique -noheader > file

m  To push from a media server, run the following command:

./bpplclients -allunique -noheader -M \
m_server_name > file

m_server_name Name of the NetBackup master server in this environment.

file

Name of the file to contain the list of unique clients. If no clients have
been configured in the NetBackup database, £i1eis empty. Create
fileusing the same format as that generated by bpplclients.

The bpplclients command writes output to file in the following
format:
hardware os client

hardware The hardware name. For examples, run the 1s command in directory

[

/usr/openv/netbackup/client.

The operating system name. For examples, run the 1s command in directory
/usr/openv/netbackup/client/hardware.

client The name of the client.

The contents of file might look like the following example:

Solaris Solaris8 machinename

m  (Optional) Edit file.
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Perform this step to change the contents of file. Edit file to contain only
those NetBackup clients you want to update with LiveUpdate agent
software.

The host names of the clients must be the clients’ individual node
names. They cannot be virtual names. The correct value for the
individual node names is returned by the hostname and the
domainname commands. The format can be either hostname or
hostname . domainname.

Run the following command:

/usr/openv/netbackup/bin/update_luagent -ClientList file
The script requests the following information:

There are N clients to upgrade.

Enter the number of simultaneous updates you wish to take place.
[N - NN] (default: NN):

Press Enter.

The upgrade will likely take Y to Z minutes.

Do you want to upgrade clients now? (y/n) [vy]
Answer y or n.

What is the protocol and location to use for the
LiveUpdate server?

Enter the appropriate protocol and pathname.

You have specified this value for the question:

Is this value correct? (y/n) [v]

Answer either y or n.

The progress and results are shown.

Changing the NetBackup LiveUpdate configuration

This section describes how to update and change the LiveUpdate configuration
settings after the initial installation and configuration.

These changes are necessary if any of the following occur:

A new version of the LiveUpdate agent is available on the NetBackup server
A different machine is designated as the NetBackup LiveUpdate server

A NetBackup LiveUpdate agent installed on a NetBackup server or client has
a problem

Keep your NetBackup LiveUpdate agent configuration current to ensure that
LiveUpdate policies run successfully.
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Changing the LiveUpdate configuration on Windows
To make any changes after the initial installation, do one of the following:

m  Launch the NetBackup installation wizard and repeat the steps in the
section “Installing on Windows systems”.

m  Modify the LU_Install.bat file as described in the section “Installing on
Windows systems”.

Changing the LiveUpdate configuration on UNIX

The following commands let you update and reconfigure your NetBackup
LiveUpdate agent software remotely:

B update_luagent -ForcelInstall
Use this command to force installation of the LiveUpdate agent to specified
clients. The command only pushes the agent software to the specified
clients. Configuration is not changed.
If the NetBackup LiveUpdate version being pushed from the server is the
same version on a specified client, you can continue or stop the forced
installation.

B update_luagent -ForceReconfig
Use this command to force installation and reconfiguration of the
LiveUpdate agent on specified clients. The command pushes the agent
software to the clients and reconfigures the protocol and NetBackup
LiveUpdate server designation on the clients.

Downloading NetBackup release updates

Before you can run a LiveUpdate policy successfully, you must download the
release updates to your NetBackup LiveUpdate server.

NetBackup release updates include a Windows .gzip file and a UNIX .gzip file.
The files are available for manual download only from the customer support
site.

Unlike Symantec LiveUpdate, NetBackup packages are not downloaded
automatically. Manual downloads respect customer sites that maintain strict
change and update control policies.

Use the following steps to download NetBackup release updates to your
NetBackup LiveUpdate server.
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To download NetBackup release updates to your NetBackup LiveUpdate

server

1 Login to your NetBackup LiveUpdate server as the administrator.

2 Open your internet browser and enter the following address:
http:\\entsupport.symantec.com

3  Select the release update to download.

4  Verify the directory on your NetBackup LiveUpdate server where you want
the package downloaded.

5 Click Download.

6  Extract the contents of one or both release updates to your NetBackup
LiveUpdate server.

7  Unzip the files.

About LiveUpdate policies

A LiveUpdate policy lets you control which NetBackup servers and clients are
updated. The manual activation required to run the policy lets you control when
the updates occur.

Use the following guidelines when you create LiveUpdate policies:

LiveUpdate policies cannot include any clients that use NetBackup versions
earlier than 6.5. LiveUpdate is only supported in NetBackup versions 6.5
and later.

Create separate LiveUpdate policies for servers and clients.

Always run the servers policy before you run the clients policy. Clients
cannot run a later version of NetBackup than the servers.

Important!

Since NetBackup services and daemons are shut down during release update
installation, do not add the following servers to a LiveUpdate policy:

m The NetBackup master server that runs the LiveUpdate policy
m  Any media server involved with running the LiveUpdate policy
These servers must be updated through the command line interface. See the

section “Updating master servers and media servers that run LiveUpdate
policies” on page 124" for complete details.

For UNIX systems, any media server name that you specify in a LiveUpdate
policy must appear in the bp . conf file on the client.


http:\\entsupport.symantec.com
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All nodes of a cluster must be updated, so make sure to include all actual
host names in a LiveUpdate policy. The best practice is to have a separate
policy for each clustered server and include all node hostnames in the policy
for that cluster.

In addition, the Limit jobs per policy attribute of the LU policy should be set
(at a minimum) to the number of nodes in the cluster. This helps ensure that
the nodes are updated simultaneously (or as close as possible), which lowers
the chance of failover in between updating the nodes. If a failover were to
occur before all nodes were updated, the NetBackup database and the
binaries on the active node could be mismatched.

Creating a LiveUpdate policy

Use the following steps to create a LiveUpdate policy.

To create a NetBackup LiveUpdate policy

1

2
3
4
5

Launch the NetBackup Administration Console.

On the File menu, select LiveUpdate.

In the LiveUpdate policy window, click New.

Enter the name you want for the policy, then click OK.

On the Attributes tab of the new LiveUpdate Policy window, select the media
server that you want to run the policy.

m For environments with no media server, select the master server that
you want to run the policy.

m Limit jobs per policy lets you select the number of LiveUpdate jobs that
are active simultaneously, when you run the policy.

Note: If a firewall prevents communication between the master server and
clients, the LiveUpdate policy must specify the media server that can
communicate with the clients.

Click on the Clients tab.

Click New and enter the name of the first client, then press <enter>.

Note: You must enter only the names of client machines that have
NetBackup 6.5 installed with the NetBackup LiveUpdate agent installed and
configured.

Repeat step 7 until all client names are entered.

After all client names are entered, click OK.
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Updating servers and clients with NetBackup

LiveUpdate

After you have created LiveUpdate policies and downloaded release updates to
your NetBackup LiveUpdate server, you are ready to update your NetBackup
environment.

Before updating your NetBackup environment, there are three important tasks
you should perform as follows:

Before updating your NetBackup environment:

1  Make sure that there are no NetBackup jobs running or queued to run on any
NetBackup servers and clients.

2 Deactivate all backup policies on all NetBackup master servers.

3 Login as a database user on the NetBackup hosts that run third-party
database software and shut down all database instances.

When you are ready to update your NetBackup environment, update servers and
clients in the following order:

m  Master servers and media servers that run LiveUpdate policies

m  Master servers and media servers not involved in running LiveUpdate
policies

m Clients

Updating master servers and media servers that run LiveUpdate

policies

Use the nbliveup command to update NetBackup master servers and media
servers that run LiveUpdate policies. Do not use a LiveUpdate policy to update
these servers.

m  Thereis a known issue when using nb11iveup on Windows IA64 and AMD64
systems. Use nbliveup on these systems with one of the following
methods:

m  Method A—Local update
You must log in as the console user to the desired machine locally or
through a remote desktop session, by using the following command:
mstsc -v:your.machine.name.com /F -console
For complete details, go to the following link:
http://support.microsoft.com/kb/278845

m  Method B—Remote update


http://support.microsoft.com/kb/278845
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Initiate the LiveUpdate session from a different NetBackup master
server.

To update master servers and media servers that run LiveUpdate policies

1  Make sure there are no active backup or restore jobs on the master server
that runs LiveUpdate policies.

2 On the master servers or media servers that run NetBackup LiveUpdate
policies, run the following command:

m  On Windows systems:
NetBackup\bin\nbliveup
m  On UNIX systems:
/usr/openv/netbackup/bin/nbliveup
3 If any master servers or media servers that run LiveUpdate policies are
themselves clustered servers, run the nbliveup sequence as follows:
m  On Windows systems:
m  On the active node, run the following command:
\NetBackup\bin\bpclusterutil -offline

m  Oneach inactive node in the cluster, run the following command:
\NetBackup\bin\nbliveup

m  On the active node, run the following command:
\NetBackup\bin\nbliveup
m  On UNIX systems:
m  On the active node, run the following command:
/usr/openv/netbackup/bin/bpclusterutil -freeze

m  On each node in the cluster, run the following command:

/usr/openv/netbackup/bin/nbliveup -c
m  On the active node, run the following command:
/usr/openv/netbackup/bin/bpclusterutil -unfreeze

Updating master severs and media servers that do not run
LiveUpdate policies
To update these servers, use the servers LiveUpdate policy that you created.
To update master servers and media servers that do not run LiveUpdate
policies
1 Launch the NetBackup Administration Console.

2 On the File menu, select LiveUpdate.
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Updating clients

In the LiveUpdate policy window, select the servers LiveUpdate policy that
you created.

Click Run LiveUpdate Policy.
Check the Activity Monitor to verify that all LiveUpdate jobs complete.

To update clients, use the clients LiveUpdate policy that you created.

To update clients

1
2
3

Launch the NetBackup Administration Console.
On the File menu, select LiveUpdate.

In the LiveUpdate policy window, select the clients LiveUpdate policy that
you created.

Click Run LiveUpdate Policy.
Check the Activity Monitor to verify that all LiveUpdate jobs complete.

LiveUpdate logs

The following procedures describe how to use LiveUpdate logging on Windows
and UNIX NetBackup systems.

On Windows servers and clients, the log directories are created when you install
NetBackup LiveUpdate.

On UNIX clients, you must first create the necessary directories to enable
logging.

To view LiveUpdate logs on Windows NetBackup servers and clients

1

To view NetBackup LiveUpdate logs, go to the following directory:
NetBackup\logs\liveupdate

To view nb1iveup command logs, go to the following directory:
NetBackup\logs\nbliveup

To view NetBackup release update logs, go to the following directory:
NetBackup\logs\patch

To enable LiveUpdate logging on UNIX NetBackup servers

Run the following command:
/usr/openv/netbackup/logs/mklogdir
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To enable LiveUpdate logging on UNIX NetBackup clients

1 Create the following directories:
/usr/openv/netbackup/logs/liveupdate
/usr/openv/netbackup/logs/nbliveup

/usr/openv/netbackup/logs/patch

2  To view NetBackup LiveUpdate logs, go to the following directory:
/usr/openv/netbackup/logs/liveupdate

3 Toview nbliveup command logs, go to the following directory:
/usr/openv/netbackup/logs/nbliveup

4  To view NetBackup patch logs, go to the following directory:
/usr/openv/netbackup/logs/patch

Retrieving logs remotely

You can retrieve LiveUpdate logs remotely from a master server by using the
bpgetdebuglog command

The remote_program argument described in the command refers to the
liveupdate, nbliveup, or patch directory.

For complete details about the bpgetdebuglog command arguments, see the
Veritas NetBackup Commands for UNIX and Linux or Veritas NetBackup
Commands for Windows documents.

To retrieve logs remotely

m  For Windows systems, enter the following:

install_path\NetBackup\bin\admincmd\bpgetdebuglogremote_

machine remote_program mmddyy

m  For UNIX systems, enter the following:

/usr/openv/netbackup/bin/admincmd/bpgetdebuglog
remote_machine remote_program mmddyy

Uninstalling NetBackup LiveUpdate

This section describes how to remove the NetBackup LiveUpdate agent and
associated files. In some cases, you may need to remove directories and files
manually.

Uninstalling on Windows systems

Use the following procedures to remove LiveUpdate files on Windows systems.
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Uninstalling NetBackup LiveUpdate

To remove NetBackup LiveUpdate on Windows systems:

1

2
3

Select Start > Control Panel.
Select Add or Remove Programs.

Click on LiveUpdate and select Remove.

Uninstalling on UNIX systems

Use the following procedures to remove LiveUpdate files on UNIX systems.

To remove NetBackup LiveUpdate components from NetBackup servers that
run on the Solaris platform

1

You must first de-register all NetBackup products with LiveUpdate by using
the following command:

/usr/openv/netbackup/bin/nblu_registration -r

To remove the NetBackup LiveUpdate agent, run the following command:
pkgrm SYMCnblua

To remove the associated LiveUpdate files, run the following commands:
rm -rf /usr/openv/netbackup/logs/liveupdate
rm -rf /usr/openv/netbackup/logs/nbliveup

rm -rf /usr/openv/netbackup/logs/patch

To remove NetBackup LiveUpdate components from NetBackup servers and
clients that run on non-Solaris platforms

1

You must first de-register all NetBackup products with LiveUpdate by using
the following command:

/usr/openv/netbackup/bin/nblu_registration -r

To remove the associated LiveUpdate files, run the following commands:
rm -f /usr/openv/netbackup/bin/install_nblu

rm -f /usr/openv/netbackup/bin/nbliveup

rm -f /usr/openv/netbackup/.luagent.conf

rm -f /usr/openv/netbackup/nblu.conf

rm -f /usr/openv/netbackup/nblu.conf.template

rm -f /usr/openv/share/version_luagent

To remove the LiveUpdate agent software from the NetBackup server that
was used to push agent software to clients, run the following command:

rm -rf /usr/openv/netbackup/luagent



Uninstalling NetBackup LiveUpdate

To remove Symantec LiveUpdate components from UNIX systems that run
NetBackup

If NetBackup is the only Symantec product that currently uses LiveUpdate,
run the following command:

/opt/Symantec/LiveUpdate/uninstall.sh -a
If LiveUpdate is the only product installed in /opt/Symantec, remove the
following files:

rm -f /etc/Symantec.conf
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